
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Operating Instruction Manual 

DTM for Hilscher CANopen Slave device 
Configuration of Hilscher Slave Devices 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Hilscher Gesellschaft für Systemautomation mbH 
www.hilscher.com 

DOC091002OI04EN | Revision 4 | English | 2010-10 | Released | Public 



Table of Contents 2/113 

DTM for Hilscher CANopen Slave device | Configuration of Hilscher Slave Devices  
DOC091002OI04EN | Revision 4 | English | 2010-10 | Released | Public  © Hilscher, 2009-2010 

Table of Contents 

1 INTRODUCTION.........................................................................................................5 
1.1 About this Manual .......................................................................................................5 

1.1.1 Descriptions of the Dialog Panes .........................................................................6 
1.1.2 Online Help...........................................................................................................6 
1.1.3 List of Revisions ...................................................................................................7 
1.1.4 Conventions in this Manual ..................................................................................7 

1.2 Legal Notes.................................................................................................................8 
1.2.1 Copyright ..............................................................................................................8 
1.2.2 Important Notes ....................................................................................................8 
1.2.3 Exclusion of Liability .............................................................................................9 
1.2.4 Warranty ...............................................................................................................9 
1.2.5 Export Regulations .............................................................................................10 
1.2.6 Registered Trademarks......................................................................................10 

1.3 About CANopen Slave DTM .....................................................................................11 
1.3.1 Requirements .....................................................................................................12 

1.4 Dialog Structure of the CANopen Slave DTM...........................................................13 
1.4.1 General Device Information................................................................................14 
1.4.2 Navigation Area ..................................................................................................14 
1.4.3 Dialog Panes ......................................................................................................15 
1.4.4 OK, Cancel, Apply and Help...............................................................................16 
1.4.5 Table Lines .........................................................................................................16 
1.4.6 Status Bar...........................................................................................................17 

2 GETTING STARTED AND STEP-INSTRUCTIONS..................................................18 
2.1 Overview Configuration Steps ..................................................................................18 

2.1.1 Slave DTM at the Root-Line (Stand-Alone Slave)..............................................18 
2.1.2 Slave DTM at the Master busline .......................................................................20 
2.1.3 Setting Driver and Selecting Device...................................................................22 
2.1.4 Configuring Slave Parameters ...........................................................................23 

3 SETTINGS ................................................................................................................24 
3.1 Overview Settings.....................................................................................................24 
3.2 Driver ........................................................................................................................25 

3.2.1 Selecting the Driver ............................................................................................25 
3.2.2 Configuring the Driver ........................................................................................26 
3.2.3 cifX Device Driver ...............................................................................................27 
3.2.4 netX Driver..........................................................................................................28 

3.3 Device Assignment ...................................................................................................35 
3.3.1 Scanning for Devices .........................................................................................36 
3.3.2 Selecting the Device (with or without firmware) .................................................39 
3.3.3 Selecting the Device once more (with Firmware)...............................................40 

3.4 Firmware Download..................................................................................................42 



Table of Contents 3/113 

DTM for Hilscher CANopen Slave device | Configuration of Hilscher Slave Devices  
DOC091002OI04EN | Revision 4 | English | 2010-10 | Released | Public  © Hilscher, 2009-2010 

4 CONFIGURATION ....................................................................................................47 
4.1 Overview Configuration ............................................................................................47 
4.2 General Settings .......................................................................................................48 
4.3 Special Function Objects ..........................................................................................50 
4.4 Object Dictionary ......................................................................................................52 
4.5 Process Data Objects ...............................................................................................56 

4.5.1 PDO Properties ..................................................................................................56 
4.5.2 PDO Mapping .....................................................................................................59 

4.6 Address Table...........................................................................................................61 
4.6.1 Description of the Paramters..............................................................................61 
4.6.2 Display Mode......................................................................................................62 

5 DEVICE DESCRIPTION ...........................................................................................63 
5.1 About Device Description .........................................................................................63 
5.2 Device.......................................................................................................................64 
5.3 EDS ..........................................................................................................................64 

6 DIAGNOSIS ..............................................................................................................65 
6.1 Overview Diagnosis ..................................................................................................65 
6.2 General Diagnosis ....................................................................................................66 
6.3 Firmware Diagnosis ..................................................................................................69 

7 EXTENDED DIAGNOSIS..........................................................................................70 
7.1 Overview Extended Diagnosis..................................................................................70 
7.2 Task Information .......................................................................................................71 
7.3 IniBatch Status..........................................................................................................72 

7.3.1 CANOPEN_SLAVE ............................................................................................73 
7.3.2 CANOPEN_APS.................................................................................................76 

8 TOOLS ......................................................................................................................78 
8.1 Overview Tools .........................................................................................................78 
8.2 Packet Monitor..........................................................................................................79 

8.2.1 Sending Packet ..................................................................................................80 
8.2.2 Receiving Packet................................................................................................81 

8.3 IO Monitor .................................................................................................................83 

9 ONLINE FUNCTIONS ...............................................................................................84 
9.1 Connecting/Disconnecting Device ............................................................................84 
9.2 Download Configuration ...........................................................................................86 

10 ERROR CODES........................................................................................................87 
10.1 Error Code Definition ................................................................................................87 
10.2 Overview Error Codes ..............................................................................................88 



Table of Contents 4/113 

DTM for Hilscher CANopen Slave device | Configuration of Hilscher Slave Devices  
DOC091002OI04EN | Revision 4 | English | 2010-10 | Released | Public  © Hilscher, 2009-2010 

10.3 General Hardware Error Codes ................................................................................89 
10.3.1 RCX General Task Errors ..................................................................................89 
10.3.2 RCX Common Status & Errors Codes ...............................................................90 
10.3.3 RCX Status & Error Codes.................................................................................91 

10.4 ODM Error Codes .....................................................................................................92 
10.4.1 General ODM Error Codes.................................................................................92 
10.4.2 General ODM Driver Error Codes ......................................................................93 
10.4.3 cifX Driver Specific ODM Error Codes ...............................................................94 

10.5 Error Codes cifX Device Driver and netX Driver .......................................................97 
10.5.1 Generic Error Codes...........................................................................................97 
10.5.2 Generic Driver Error Codes................................................................................98 
10.5.3 Generic Device Error Codes ..............................................................................99 

10.6 Error Codes netX Driver .........................................................................................100 
10.6.1 CIFX API Transport Error Codes......................................................................100 
10.6.2 CIFX API Transport Header State Error Codes ...............................................100 

10.7 ODM Error Codes DBM V4.....................................................................................101 

11 APPENDIX ..............................................................................................................105 
11.1 COB-ID (Predefined Connection Set) .....................................................................105 
11.2 User Rights .............................................................................................................106 

11.2.1 Settings.............................................................................................................106 
11.2.2 Configuration ....................................................................................................106 

11.3 References .............................................................................................................107 

12 LISTS ......................................................................................................................108 
12.1 List of Figures .........................................................................................................108 
12.2 List of Tables ..........................................................................................................110 

13 GLOSSARY.............................................................................................................112 
13.1 Contacts..................................................................................................................113 

 

 



Introduction 5/113 

DTM for Hilscher CANopen Slave device | Configuration of Hilscher Slave Devices  
DOC091002OI04EN | Revision 4 | English | 2010-10 | Released | Public  © Hilscher, 2009-2010 

1 Introduction 
1.1 About this Manual 

This manual provides information on how to set and configure the device 
parameters of a CANopen Slave within a FDT Framework using the 
CANopen Slave DTM, and what can be read from the diagnosis panes. 

In network project the CANopen Slave DTM can be dropped: 

• to the root line (Stand-Alone Slave), 

• or to the Master busline of a CANopen Master DTM netX. 
 

 
Note: This manual edition first provides information for the case, if the 
CANopen Slave DTM is dropped to the root line (Stand-Alone Slave) and 
in addition important information for the case, if the CANopen Slave DTM 
is dropped to the Master busline of a CANopen Master DTM netX. 
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1.1.1 Descriptions of the Dialog Panes 
The table below gives an overview for the individual dialog panes 
descriptions: 
 

Section Subsection Manual  
Page 

Settings Overview Settings  24 
 Driver 25 
 Device Assignment 35 
 Firmware Download 42 
Configuration Overview Configuration 47 
 General Settings  48 
 Special Function Objects 50 
 Object Dictionary 52 
 Process Data Objects 56 
    PDO Properties 56 
    PDO Mapping 59 
 Address Table  61 
Device Description Device  64  
 EDS 64 
Diagnosis Overview Diagnosis 65 
 General Diagnosis  66 
 Firmware Diagnosis 69 
Extended Diagnosis Overview Extended Diagnosis 70 
Tools Overview Tools  78 
 Packet Monitor 79 
 IO Monitor 83 

Table 1:  Descriptions Dialog Panes 

 
 

1.1.2 Online Help 
The CANopen Slave DTM contains an integrated online help facility. 

 To open the online help, click on the Help button or press the F1 key. 
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1.1.3 List of Revisions 
Index Date Version Component Chapter Revision 
1 23.10.09 1.0.0.4759 

1.0.0.4759 
CANoSlaveDTM.dll 
CANoSlaveGUI.ocx 

All created 

2 09.08.10 1.2.x.x 
1.0.x.x 

CANoSlaveDTM.dll 
CANoSlaveGUI.ocx 

3.2.4, 
3.3, 
10 

Section netX Driver added‚ 
Section Device Assignment’ actualized, 
Chapter Error Codes actualized and 
completed. 

3 12.10.10 1.3.x.x 
1.0.x.x 

CANoSlaveDTM.dll 
CANoSlaveGUI.ocx 

8.2 
 

Section Packet Monitor actualized. 

4 19.10.10 1.3.x.x 
1.0.x.x 

CANoSlaveDTM.dll 
CANoSlaveGUI.ocx 

8.2 
 

Section Packet Monitor actualized. 

 
 

1.1.4 Conventions in this Manual 
Operation instructions, a result of an operation step or notes are marked as 
follows: 

Operation Instructions: 
 

 <instruction> 
 

Or 
 

1. <instruction> 

2. <instruction> 
 

Results: 
 

<result> 
 

Notes: 
 

 

Important: <important note> 

 

 
Note:  <note> 

 

 

 <note, were to find further information> 
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1.2 Legal Notes 

1.2.1 Copyright 
© 2008-2010 Hilscher Gesellschaft für Systemautomation mbH   

All rights reserved. 

The images, photographs and texts in the accompanying material (user 
manual, accompanying texts, documentation, etc.) are protected by 
German and international copyright law as well as international trade and 
protection provisions. You are not authorized to duplicate these in whole or 
in part using technical or mechanical methods (printing, photocopying or 
other methods), to manipulate or transfer using electronic systems without 
prior written consent. You are not permitted to make changes to copyright 
notices, markings, trademarks or ownership declarations. The included 
diagrams do not take the patent situation into account. The company 
names and product descriptions included in this document may be 
trademarks or brands of the respective owners and may be trademarked or 
patented. Any form of further use requires the explicit consent of the 
respective rights owner. 
 

 

1.2.2 Important Notes 
The user manual, accompanying texts and the documentation were created 
for the use of the products by qualified experts, however, errors cannot be 
ruled out. For this reason, no guarantee can be made and neither juristic 
responsibility for erroneous information nor any liability can be assumed. 
Descriptions, accompanying texts and documentation included in the user 
manual do not present a guarantee nor any information about proper use 
as stipulated in the contract or a warranted feature. It cannot be ruled out 
that the user manual, the accompanying texts and the documentation do 
not correspond exactly to the described features, standards or other data of 
the delivered product. No warranty or guarantee regarding the correctness 
or accuracy of the information is assumed.  

We reserve the right to change our products and their specification as well 
as related user manuals, accompanying texts and documentation at all 
times and without advance notice, without obligation to report the change. 
Changes will be included in future manuals and do not constitute any 
obligations. There is no entitlement to revisions of delivered documents. 
The manual delivered with the product applies.  

Hilscher Gesellschaft für Systemautomation mbH is not liable under any 
circumstances for direct, indirect, incidental or follow-on damage or loss of 
earnings resulting from the use of the information contained in this 
publication. 
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1.2.3 Exclusion of Liability 
The software was produced and tested with utmost care by Hilscher 
Gesellschaft für Systemautomation mbH and is made available as is. No 
warranty can be assumed for the performance and flawlessness of the 
software for all usage conditions and cases and for the results produced 
when utilized by the user. Liability for any damages that may result from the 
use of the hardware or software or related documents, is limited to cases of 
intent or grossly negligent violation of significant contractual obligations. 
Indemnity claims for the violation of significant contractual obligations are 
limited to damages that are foreseeable and typical for this type of contract. 

It is strictly prohibited to use the software in the following areas: 

• for military purposes or in weapon systems;  

• for the design, construction, maintenance or operation of nuclear 
facilities; 

• in air traffic control systems, air traffic or air traffic communication 
systems;  

• in life support systems;  

• in systems in which failures in the software could lead to personal injury 
or injuries leading to death. 

We inform you that the software was not developed for use in dangerous 
environments requiring fail-proof control mechanisms. Use of the software 
in such an environment occurs at your own risk. No liability is assumed for 
damages or losses due to unauthorized use. 

 

 

1.2.4 Warranty 
Although the hardware and software was developed with utmost care and 
tested intensively, Hilscher Gesellschaft für Systemautomation mbH does 
not guarantee its suitability for any purpose not confirmed in writing. It 
cannot be guaranteed that the hardware and software will meet your 
requirements, that the use of the software operates without interruption and 
that the software is free of errors. No guarantee is made regarding 
infringements, violations of patents, rights of ownership or the freedom from 
interference by third parties. No additional guarantees or assurances are 
made regarding marketability, freedom of defect of title, integration or 
usability for certain purposes unless they are required in accordance with 
the law and cannot be limited. Warranty claims are limited to the right to 
claim rectification. 

 

 



Introduction 10/113 

DTM for Hilscher CANopen Slave device | Configuration of Hilscher Slave Devices  
DOC091002OI04EN | Revision 4 | English | 2010-10 | Released | Public  © Hilscher, 2009-2010 

1.2.5 Export Regulations 
The delivered product (including the technical data) is subject to export or 
import laws as well as the associated regulations of different counters, in 
particular those of Germany and the USA. The software may not be 
exported to countries where this is prohibited by the United States Export 
Administration Act and its additional provisions. You are obligated to 
comply with the regulations at your personal responsibility. We wish to 
inform you that you may require permission from state authorities to export, 
re-export or import the product. 

 

 

1.2.6 Registered Trademarks 
Windows® 2000 and Windows® XP are registered trademarks of Microsoft 
Corporation. 

CANopen® is a registered trademark of CAN in AUTOMATION - 
International Users and Manufacturers Group e.V (CiA), Nürnberg. 

All other mentioned trademarks are property of their respective legal 
owners. 
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1.3 About CANopen Slave DTM 
You can use the CANopen Slave DTM to configure CANopen Slave 
devices within a FDT Framework and to view the device diagnosis. 

In network project the CANopen Slave DTM can be dropped: 

• to the root line (Stand-Alone Slave), 

• or to the Master busline of a CANopen Master DTM netX. 

 

Slave DTM at the Root-Line (Stand-Alone Slave) 
Insert the CANopen Slave DTM to the root busline, if you intend to 
configure only one Slave device. 

Slave DTM at the Master busline 
Insert the CANopen Slave DTM to the Master busline of the CANopen 
Master DTM netX, if within the network project the Slave device and the 
Master device are used, i. e., if you intend to configure the Slave device 
and the Master device. 
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1.3.1 Requirements 
System Requirements 

• Windows® 2000/ Windows® XP 

• CD ROM drive 

• Graphic resolution: min. 1024 x 768 pixel 

• Keyboard and Mouse 
 

Requirements CANopen Slave DTM 
To configure a CANopen Slave device with a DTM the following 
requirements have to be accomplished: 

• Completed hardware installation of a DTM-compatible CANopen Slave 
device, inclusive loaded firmware and loaded configuration file 

• Installed FDT/DTM V 1.2 compliant frame application 

• Installed CANopen Master DTM (If Slave DTM is dropped to the Master 
busline.) 

• Loaded DTM in the Device Catalog of the FTD Framework 
 

 

For more information to the hardware installation, please refer to the 
corresponding user manual of your device.  
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1.4 Dialog Structure of the CANopen Slave DTM 
The graphical user interface of the DTM is composed of different areas and 
elements listed hereafter: 

1. A header area containing the General Device Information, 

2. The Navigation Area (area on the left side), 

3. The Dialog Pane (main area on the right side), 

4. OK, Cancel, Apply, Help, 

5. The Status Line containing information e. g. the online-state of the 
utility. 

 

General Device Information 

 
 
Navi- 
gation 
Area 

 
 
 

Dialog Pane 

 OK Cancel Apply Help 

Status Line 

Figure 1: Dialog Structure of the CANopen Slave DTM 
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1.4.1 General Device Information 
 

Parameter Meaning 
IO Device Name of the device 
Vendor Vendor name of the device 
Device ID Identification number of the device 
Vendor ID Identification number of the vendor 

Table 2: General Device Information 

 

1.4.2 Navigation Area 
The Navigation Area contains folders an subfolders to open the dialog 
panes of the DTM. 
 

Navigation Area 

 Settings 
Driver 

 Device Assignment 
 Firmware Download 
 Configuration 

 

  

Figure 2: Navigation Area 

 

 Select the required folder and subfolder. 

 The corresponding Dialog pane is displayed.  

Hide / display Navigation 
 

Hiding the navigation area (above right side). 

 
Opening the navigation area (below left side). 
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1.4.3 Dialog Panes 
Settings 
   Driver On the pane Driver you can select a driver from the driver list. 

For further information, refer to section Driver on page 25. 
    Device 
Assignment 

On the pane Device Assignment you select the device and 
assign the device to the driver. For further information, refer to 
section Device Assignment on page 35. 

   Firmware 
Download 

The dialog on the pane Firmware Download is used to load a 
new firmware into the device. A detailed description can be 
found in section Firmware Download on page 42. 

Configuration 
   General The dialog General Settings displays EDS file data. For further 

information see section General Settings on page 48. 
   Special Function 
   Objects 

The dialog Special Function Objects displays data of the 
synchronization, time stamp and emergency telegram. For 
further information see section Special Function Objects on 
page 50. 

   Object Dictionary The dialog Object Dictionary represents the object dictionary of 
the device. The display shows data read out from the EDS file. 
For further information see section Object Dictionary on page 
52. 

   Process Data  
   Objects 

PDO Properties: 
In the dialog PDO Properties the transmit and the receive PDOs 
are displayed. For further information see section PDO 
Properties on page 56. 

 PDO Mapping: 
The dialog PDO Mapping permits to map the contents of a PDO. 
For further information see section PDO Mapping on page 59. 

   Address Table The Address Table shows a list of all dpram address used in the 
process data image. For further information, refer to section 
Address Table on page 61. 

Device Description 
   Device The Device Info pane contains the manufacturer information 

about the device. Further information to this you find in section 
Device on page 64. 

   EDS By use of the EDS-Viewer a EDS file can be searched through. 
Further information to this you find in section EDS on page64 . 

Diagnosis 
   Diagnosis/ 
   Extended 
Diagnosis 

At the Diagnosis panes diagnosis information can be read. For 
further information, refer to section Overview Diagnosis on page 
65. 

Tools 
   Packet Monitor/ 
   IO Monitor 

Under Tools the Packet Monitor and the IO Monitor are provided 
for test and diagnosis purposes. For further information, refer to 
section Packet Monitor on page 79 or section IO Monitor on 
page 83. 

Table 3: Overview Dialog Panes 
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Note: Accessing the Diagnosis panes of the CANopen Slave DTM 
requires an online connection from the CANopen Slave DTM to the 
CANopen Slave DTM.  

 
 

 

For further information, refer to section Connecting/Disconnecting Device 
on page 84. 

 
 
 
 
 

1.4.4 OK, Cancel, Apply and Help 
OK, Cancel, Apply and Help you can use as described hereafter. 
 

 Meaning 
OK To confirm your latest settings, click OK. All changed values will be applied 

on the frame application database.  
The dialog then closes. 

Cancel To cancel your latest changes, click Cancel.  
Answer to the safety query Configuration data has been changed. Do 
you want to save the data? by Yes, No or Cancel. 
Yes: The changes are saved or the changed values are applied on the 
frame application database.  
The dialog then closes. 
No: The changes are not saved or the changed values are not applied on 
the frame application database.  
The dialog then closes. 
Cancel: Back to the DTM. 

Apply To confirm your latest settings, click Apply. All changed values will be 
applied on the frame application database.  
The dialog remains opened. 

Help To open the DTM online help, click Help.  

Table 4: OK, Cancel, Apply and Help 

 

1.4.5 Table Lines 
In the DTM dialog pane table lines can be selected, inserted or deleted. 
 

 Meaning 

 
To select the first line of a table use First Line. 

 
To select the previous line of a table use Previous Line. 

 
To select the next line of a table use Next Line. 

 
To select the last line of a table use Last Line. 

 
Create a new Line inserts new lines into the table. 

 
Delete selected Line deletes the selected line from the table.  

Table 5: Selecting, inserting, deleting Table Line 
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1.4.6 Status Bar 
The Status Bar displays information about the current state of the DTM. 
The current activity, e.g. download, is signaled graphically via icons in the 
status bar. 

 
Figure 3: Status Bar – Status Fields 1 to 6 

 

Status 
Field 

Icon / Meaning 

1 DTM Connection States 
 

 
Connected: Icon closed = Device is online 

 
 

Disconnected: Icon opened = Device is offline 

2 Data Source States 
 

 
Data set: The displayed data are read out from the instance data set 
(database). 

 
 

Device: The displayed data are read out from the device. 

3 States of the instance Date Set 
 

 
Valid Modified: Parameter is changed (not equal to data source). 

4 Changes directly made on the Device 
 

 
Load/configure diagnosis parameters: Diagnosis is activated. 

6 Device Diagnosis Status 

Save operation succeeded: The save operation has been successful.  
 

Further messages due to successful handling of device data. 

   Firmware Download: Firmware Download is running 

Save operation failed: The save operation has failed.  
 

Further fail operation messages due to incorrect communication due to 
malfunction in the field device or its peripherals. 

Table 6: Status Bar Icons [1] 

 

Offline State 
 

 

Save operation 
succeeded 

 

Firmware Download 
 

 

Firmware Download 
successful  

 

Online State and 
Diagnosis  

Figure 4: Status Bar Display Examples 
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2 Getting Started and Step-Instructions 
 

2.1 Overview Configuration Steps 
The following tables describe the steps to configure a CANopen Slave 
device with the CANopen Slave DTM for the two cases listed hereafter, as 
it is typical for many cases: 

• Slave DTM at the Root-Line (Stand-Alone Slave)  

• and Slave DTM at the Master busline.  

At this time it is presupposed that the hardware installation was done. 
 

2.1.1 Slave DTM at the Root-Line (Stand-Alone Slave) 
 

# Step Short Description For detailed information 
see section 

Page 

1 Load device catalog Depending of the FDT Container: 
For netDevice: 
- select Network > Device Catalog, 
- select button Reload Catalog. 

 
(See User Manual netDevice 
and netProject) 

- 

2 Create new project / 
Open existing project 

Depending of the frame application. 
For the configuration software: 
- select File > New or File > Open. 

 
(See User Manual of the 
Frame Application) 

- 

3 Insert Slave into 
configuration 

Depending of the FDT Container: 
For netDevice: 
- in the Device Catalog click to the Slave, 
- and insert the Slave via drag and drop  
to the root line in the network view. 

 
(See User Manual netDevice 
and netProject) 

- 

4 Open the Slave DTM 
configuration dialog  

Open the Slave DTM configuration dialog. 
- Double click to the device icon of the Slave. 
- The Slave DTM configuration dialog is 
displayed. 

- - 

5 Select driver In the Slave DTM configuration dialog: 
- select Settings > Driver, 
- select a driver, 
- therefore check the appropriate checkbox. 

Setting Driver and Selecting 
Device 
Driver 

22 
 
25 

6 Configure Driver If necessary, configure the driver settings. 
For netX Driver and communication via TCP/IP 
set the IP address of the device: 
- Select Settings > Driver > netX Driver > TCP 
Connection. 
- Via  add an IP range. 
- Under IP Address enter the IP Address of the 
device or an IP range. 
- Click Save. 

 
 
 
netX Driver 

 
 
 
28 
 

7 Assign Slave device 
(with or without 
firmware) 

Assign the device to this driver. 
In the Slave DTM configuration dialog: 
- select Settings > Device Assignment, 
- select a Slave device (with or without firmware), 
- therefore check the appropriate checkbox, 
- select the button Apply. 

Selecting the Device (with or 
without firmware) 

39 

8 Select and download 
firmware 

If not yet a firmware was loaded to the device. 
In the Slave DTM configuration dialog: 
- select Settings > Firmware Download, 
- select the button Browse.., 
- select a firmware file, 
- select the button Open, 
- select the buttons Download and Yes. 

Firmware Download 42 
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# Step Short Description For detailed information 
see section 

Page 

9 Assign Slave device 
once more (with 
firmware) 

In the Slave DTM configuration dialog: 
- select Settings > Device Assignment, 
- select the button Scan, 
- select the Slave device (with loaded firmware), 
- therefore check the appropriate checkbox, 
- select the button Apply, 
- close the Slave DTM configuration dialog via  
the button OK. 

Selecting the Device once 
more (with Firmware) 

40 

10 Configure Slave 
device 

Configure the Slave device. 
- Double click to the device icon of the Slave. 
- The Slave DTM configuration dialog is 
displayed. 
In the Slave DTM configuration dialog: 
- select Configuration >Object Dictionary, 
- define the object filters, 
- select Configuration > Process Data Objects 
> PDO Properties, 
- configure the PDO to be used for the 
communication,  
- select Configuration > Process Data Objects 
> PDO Mapping, 
- configure the list of the mappable or the list of 
the mapped objects each, 
- close the Slave DTM configuration dialog via  
the button OK. 

Configuring Slave 
Parameter 
 
 
 
Object Dictionary 
 
 
PDO Properties 
 
 
PDO Mapping 
 

23 
 
 
 
52 
 
 
56 
 
 
59 

11 Save project Depending of the frame application. 
For the configuration software: 
- select File > Save. 

 
(See User Manual of the 
Frame Application) 

- 

12 Connect Slave device Depending of the FDT Container. 
For netDevice: 
- right click to the device icon of the Slave, 
- select context menu entry Connect. 

Connecting/Disconnecting 
Device 

84 

13 Download 
Configuration 

Depending of the FDT Container. 
For netDevice:  
- right click to the device icon of the Slave, 
- select context menu entry Download. 

Download Configuration 86 

14 Diagnosis Depending of the FDT Container. 
For netDevice: 
- right click to the device icon of the Slave, 
- select context menu entry Diagnosis. 
- The Slave DTM diagnosis dialog is displayed. 
- Continue with further device diagnsosis, 
- close the Slave DTM diagnosis dialog via  
the button OK. 

Overview Diagnosis 65 

15 IO Monitor Depending of the FDT Container: 
For netDevice: 
- right click to the device icon of the Slave, 
- select context menu entry Diagnosis,  
- select Tools > IO Monitor.  
- Check the input or output data. 

IO Monitor 83 

16 Disconnect Depending of the FDT Container. 
For netDevice:  
- right click to the device icon of the Slave, 
- select context menu entry Disconnect. 

Connecting/Disconnecting 
Device 

84 

Table 7: Getting Started - Configuration Steps  (Slave DTM at the Root-Line (Stand-Alone 
Slave)) 
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2.1.2 Slave DTM at the Master busline 
 

# Step Short Description For detailed information 
see section 

Page 

1 Load device catalog Depending of the FDT Container: 
For netDevice: 
- select Network > Device Catalog, 
- select button Reload Catalog. 

 
(See User Manual netDevice 
and netProject) 

- 

2 Create new project / 
Open existing project 

Depending of the frame application. 
For the configuration software: 
- select File > New or File > Open. 

 
(See User Manual of the 
Frame Application) 

- 

3 Insert Master or Slave 
into configuration 

For netDevice: 
- in the Device Catalog click to the Master, 
- and insert the device via drag and drop  
to the root line in the network view, 
- in the Device Catalog click to the Slave, 
- and insert the device via drag and drop  
to the Master bus line in the network view. 

 
(See User Manual netDevice 
and netProject) 

- 

4 Open the Slave DTM 
configuration dialog  

Open the Slave DTM configuration dialog. 
- Double click to the device icon of the Slave. 
- The Slave DTM configuration dialog is 
displayed. 

- - 

5 Select driver In the Slave DTM configuration dialog: 
- select Settings > Driver, 
- select a driver, 
- therefore check the appropriate checkbox. 
- if necessary, configure the driver settings. 

Setting Driver and Selecting 
Device 
Driver 

22 
 
25 

6 Configure Driver If necessary, configure the driver settings. 
For netX Driver and communication via TCP/IP 
set the IP address of the device: 
- Select Settings > Driver > netX Driver > TCP 
Connection. 
- Via  add an IP range. 
- Under IP Address enter the IP Address of the 
device or an IP range. 
- Click Save. 

 
 
 
netX Driver 

 
 
 
28 
 

7 Assign Slave device 
(with or without 
firmware) 

Assign the device to this driver. 
In the Slave DTM configuration dialog: 
- select Settings > Device Assignment, 
- select a Slave device (with or without firmware), 
- therefore check the appropriate checkbox, 
- select the button Apply. 

Selecting the Device (with or 
without firmware) 

39 

8 Select and download 
firmware 

If not yet a firmware was loaded to the device. 
In the Slave DTM configuration dialog: 
- select Settings > Firmware Download, 
- select the button Browse.., 
- select a firmware file, 
- select the button Open, 
- select the buttons Download and Yes. 

Firmware Download 42 

9 Assign Slave device 
once more (with 
firmware) 

In the Slave DTM configuration dialog: 
- select Settings > Device Assignment, 
- select the button Scan, 
- select the Slave device (with loaded firmware), 
- therefore check the appropriate checkbox, 
- select the button Apply, 
- close the Slave DTM configuration dialog via  
the button OK. 

Selecting the Device once 
more (with Firmware) 

40 
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# Step Short Description For detailed information 
see section 

Page 

10 Configure Slave 
device  

Configure the Slave device. 
- Double click to the device icon of the Slave. 
- The Slave DTM configuration dialog is 
displayed. 
In the Slave DTM configuration dialog: 
- select Configuration >Object Dictionary, 
- define the object filters, 
- select Configuration > Process Data Objects 
> PDO Properties, 
- configure the PDO to be used for the 
communication,  
- select Configuration > Process Data Objects 
> PDO Mapping, 
- configure the list of the mappable or the list of 
the mapped objects each, 
- close the Slave DTM configuration dialog via  
the button OK. 

Configuring Slave 
Parameter 
 
 
 
Object Dictionary 
 
 
PDO Properties 
 
 
PDO Mapping 
 

23 
 
 
 
52 
 
 
56 
 
 
59 

11 Configure Master 
device  

Configure the Master device via the CANopen 
Master DTM netX. 

(See User Manual DTM for 
CANopen Master devices) 

- 

12 Save project Depending of the frame application. 
For the configuration software: 
- select File > Save. 

 
(See User Manual of the 
Frame Application) 

- 

13 Connect Slave device Depending of the FDT Container. 
For netDevice: 
- right click to the device icon of the Slave, 
- select context menu entry Connect. 

Connecting/Disconnecting 
Device 

84 

14 Download 
Configuration 

Depending of the FDT Container. 
For netDevice:  
- right click to the device icon of the Slave, 
- select context menu entry Download. 

Download Configuration 86 

15 Diagnosis Depending of the FDT Container. 
For netDevice: 
- right click to the device icon of the Slave, 
- select context menu entry Diagnosis. 
- The Slave DTM diagnosis dialog is displayed. 
- Continue with further device diagnsosis, 
- close the Slave DTM diagnosis dialog via  
the button OK. 

Overview Diagnosis 65 

16 IO Monitor Depending of the FDT Container: 
For netDevice: 
- right click to the device icon of the Slave, 
- select context menu entry Diagnosis,  
- select Tools > IO Monitor.  
- Check the input or output data. 

IO Monitor 83 

17 Disconnect Depending of the FDT Container. 
For netDevice:  
- right click to the device icon of the Slave, 
- select context menu entry Disconnect. 

Connecting/Disconnecting 
Device 

84 

Table 8: Getting Started - Configuration Steps (Slave DTM at the Master busline) 
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2.1.3 Setting Driver and Selecting Device 
 

The following steps are needed to establish a connection from the 
CANopen Slave DTM to the CANopen Slave device: 

Under Settings in the Driver pane: 

1. Select one or several driver/s. 

2. Configure the driver, if necessary.  

 For netX Driver and communication via TCP/IP set the IP address of 
the device. 

Under Settings in the Device Assignment pane: 

3. Scan for the device/s (with or without firmware). 

4. Select the device (with or without firmware) and apply the selection. 

Under Settings in the Firmware Download pane, if not yet a firmware was 
loaded to the device: 

5. Select and download the firmware. 

Under Settings in the Device Assignment pane, if not yet a firmware was 
loaded to the device: 

6. Scan for the device (with firmware) once more. 

7. Select the device (with firmware) once more. 
 

 

An overview of the descriptions for these steps you find in the section 
Overview Settings on page 24. 

 

8. In the DTM interface dialog select the OK button, to apply the selection 
and to close the DTM interface dialog. 

9. Put a right-click on the CANopen Slave device icon. 

10. Select the Connect command from the context menu. 

 The CANopen Slave device now is connected to the CANopen Slave 
DTM via an online connection. In the network view the device 
description at the device icon of the Slave is displayed with a green 
colored background. 
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2.1.4 Configuring Slave Parameters 
 

The following steps are needed to configure the device parameters using 
the CANopen Slave DTM. This is valid for the two cases listed hereafter: 

• Slave DTM at the Root-Line (Stand-Alone Slave)  

• and Slave DTM at the Master busline.  

Steps: 

1. Define the object filters. 

 Select Configuration >Object Dictionary in the navigation area. 

2. Configure the PDO. 

 Select Configuration > Process Data Objects > PDO Properties in 
the navigation area. 

 Configure the PDO to be used for the communication. 

3. Configure the PDO Mapping. 

 Select Configuration > Process Data Objects > PDO Mapping in the 
navigation area. 

 Configure the list of the mappable or the list of the mapped objects 
each. 

 

 

For more information refer to section Object Dictionary on page 52, PDO 
Properties on page 56 and PDO Mapping on page 59. 
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3 Settings 
3.1 Overview Settings 

Settings Dialog Panes 
The table below gives an overview for the individual Settings dialog panes 
descriptions: 
 

Section Subsection Page 
Driver  25 
 Selecting the Driver 25 
 Configuring the Driver 26 
 cifX Device Driver 27 
 netX Driver 28 
Device Assignment  35 
 Scanning for Devices 36 
  Scanning for all Devices or for 

suitable only 
38 

 Selecting the Device (with or without firmware) 39 
 Selecting the Device once more (with Firmware) 40 
Firmware 
Download 

 42 

Table 9: Descriptions Settings 

 

 
Figure 5: Navigation Area - Settings 

 

 
Note: To edit the Settings dialog panes you need User Rights for 
“Maintenance”. 

 
 

 

Notice the descriptions in the section Overview Configuration Steps on 
page 18. 
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3.2 Driver 
The Driver dialog pane displays the driver/s to be used for a CANopen 
Slave DTM to device communication connection.  

 
Figure 6: Driver Selection List 

 

Parameter Meaning 
Driver Name of the driver 
Version  Version of the driver 
ID ID of the driver (driver identification) 

Table 10: Driver Selection List Parameters 

 

3.2.1 Selecting the Driver 
To establish a connection you need to select a driver first.  
 

 
Note: Not all the drivers displayed necessarily support the device. The 
used driver must be supported by the device or must be available for the 
device. 

 

To select the driver/s to be used: 

1. Select Settings > Driver in the navigation area.  

 The available drivers are listed on the Driver dialog pane. 

 
Figure 7: Driver Selection List - recognized or installed Drivers 

 

1. Check the checkbox for the driver/s in the selection list. 

 
Figure 8: Driver Selection List - Driver/s selected 
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3.2.2 Configuring the Driver 
All drivers for which you can access to an individual driver dialog pane are 
displayed in the navigation area under the Driver entry. In the driver dialog 
panes you can configure the driver settings. 

For some drivers no individual driver dialog panes exist, since no driver 
settings are required, e. g. for the cifX Device Driver. 
 

 
Note: At the driver dialog panes under Settings > Driver the driver 
settings can be configured. 

 

 
Figure 9: Navigation Area – Settings 

To configure a driver: 

1. Select Settings > Driver > [Name of the assigned driver]. 

 The corresponding driver dialog pane is displayed. 

2. Configure the driver settings. 

 To get detailed information how to configure the single drivers, please 
refer to the corresponding description of the driver.  

 

 

You can access to the single descriptions of the drivers as online help via 
the DTM user interface (F1 key). 

 

To access to the online help with the descriptions of the drivers: 

 Select Settings > Driver > [Name of the assigned driver]. 

 Press the F1 key.  
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3.2.3 cifX Device Driver 
In the CANopen Slave DTM for the cifX Device Driver no driver dialog 
pane is available, since for the cifX Device Driver no driver settings are 
required. 

The cifX Device Driver is used, if the CANopen Slave DTM is installed in 
the same PC as the CANopen Slave device.  
 

 
Note: To establish a connection from a DTM to a Slave device via the 
cifX Device Driver, the cifX Device Driver must be installed and the 
driver must have access to the Slave device. 
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3.2.4 netX Driver 
The netX Driver is used to connect the DTM to the device via different 
connection types. The DTM communicates with the device via an USB 
connection, a serial (RS232) connection or a TCP/IP connection. The netX 
Driver establishes 

• via the USB interface of the device and the USB port of the PC an USB 
connection to the device, 

• via the RS232 interface of the device and the COM port of the PC a 
serial connection (RS232) to the device 

• and via Ethernet a TCP/IP connection to the device. 
 

To connect the DTM to the physical layer of the device the netX Driver 
software works in combination with the software components: 

• “USB/COM connector” for the USB connection and for the serial 
connection (RS232) and  

• “TCP/IP connector” for the Ethernet connection. 
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3.2.4.1 netX Driver - USB/RS232 Connection 

The communication from the DTM to the device via an USB/RS232 
Connection is used when the DTM is installed on a PC and between the 
PC and the device 

• an USB connection 

• or a serial connection (RS232) exists. 
 

The DTM accesses to the device via the USB interface or via the RS232 
interface of the device. This requires either to connect an USB port of the 
PC to the USB interface of the device using an USB cable or to connect a 
physical COM port of the PC to the RS232 interface of the device via a 
serial cable. 

The netX Driver / USB/RS232 Connection supports all physical and 
virtual COM ports available at the PC. 

Via the RS232 interface or USB interface of the device, the device is 
configured or diagnosis is performed. 
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3.2.4.2 Driver Parameters for netX Driver - USB/RS232 Connection 

The settings of the driver parameters for the USB/RS232 connection are 
made via the netX Driver / USB/RS232 Connection configuration dialog. 

 Open the USB/RS232 Connection dialog via navigation area Settings 
> Driver > netX Driver.  

 The USB/RS232 Connection dialog is displayed: 

 
Figure 10: netX Driver > USB/RS232 Connection  

 

Parameter Meaning Range of Value / Value 
Enable USB/RS232 
Connector (Restart of 
ODM required) 

checked: The netX Driver can communicate via the 
USB/RS232 interface. 
unchecked: The netX Driver can not communicate via the 
USB/RS232 interface. 
If the check mark for Enable USB/RS232 Connector is set 
or removed, then the ODM server must be restarted1, to 
make the new setting valid. 
_______ 
1 Restart the ODM server via the ODMV3 Tray Application: 

-In the foot line click to  using the right mouse key.  

- In the context menu select Service > Start. 

checked,  
unchecked; 
Default: 
unchecked  

Select Port Depending which COM ports (interfaces) are available on 
the PC; they will be listed under Select Port. 

COM 1 to COM N 

Port Configuration 
Disable Port checked: No connection. 

unchecked: The netX Driver tries to establish a connection 
using the configured USB/RS232 interface. 

checked,  
unchecked (Default) 

Baud rate Transfer rate: number of bits per second. 
The device must support the baud rate. 

9.6, 19.2, 38.4, 57.6 or 
115.2 [kBit/s]; 
Default (RS232): 115.2 
[kBit/s] 
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Parameter Meaning Range of Value / Value 
Stop bits Number of stop bits sent after the transfer of the send data 

for synchronization purposes to the receiver. 
Stop bit: 1, 1.5, 2; 
Default (RS232): 1 

Send Timeout [ms] Maximum time before the transfer of the transmission data is 
canceled, when the send process fails, for example, because 
of the transfer buffer is full.  

100 … 60.000 [ms]; 
Default (RS232 and 
USB): 1000 ms 

Reset Timeout [ms] Maximum time for a device reset, including the re-
initialization of the physical interface used for the 
communication. 

100 … 60.000 [ms]; 
Default (RS232 and 
USB): 5000 ms 

Byte size Number of bits per byte by byte specification 7 Bit, 8 Bit; 
Default (RS232): 8 Bit 

Parity In the error detection in data transmission using parity bits, 
"parity" describes the number of bits occupied with 1 in the 
transmitted information word. 
No Parity: no parity bit 
Odd Parity: The parity is "odd ", if the number of bits 
occupied with 1 in the transmitted information word is odd. 
Even parity: The parity is "even", if the number of bits 
occupied with 1 in the transmitted information word is even. 
Mark Parity: if the parity bit is always 1, this is named mark-
parity (it contains no information). 
Space Parity: if the parity bit always 0, this is named space-
parity (it is an empty space). 

No Parity,  
Odd Parity, 
Even Parity, 
Mark Parity, 
Space Parity; 
Default (RS232):  
No Parity 

Keep Alive Timeout 
[ms] 

The "Keep Alive" mechanism is used to monitor whether the 
connection to the device is active. Connection errors are 
detected using a periodic heartbeat mechanism. The 
heartbeat mechanism is initiated after the set time has 
elapsed, if the communication has failed. 

100 … 60.000 [ms]; 
Default (RS232 and 
USB): 2000 ms 

Restore Resets all settings in the configuration dialog to the default 
values. 

 

Save Saving all settings made in the configuration dialog netX 
Driver > Save USB/RS232 Connection, i. e. only for the 
selected connection type. 

 

Save All Saving all settings made in the configuration dialog netX 
Driver, i. e. for all connection types. 

 

Table 11: Parameters netX Driver > USB/RS232 Connection 
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3.2.4.3 netX Driver - TCP/IP Connection 

The communication from the DTM to the device via a TCP/IP Connection 
is used in the following two typical applications: 

Application 1: The device has its own Ethernet interface. The DTM is 
installed on a PC and the TCP/IP connection is established from this PC to 
the stand-alone device. The IP address of the device is used. 

Application 2: The device is installed in a remote PC. The DTM is installed 
on an additional PC and the TCP/IP connection is established from this PC 
to the remote PC. The IP address of the remote PC is used. For the TCP/IP 
connection is made, on the remote PC the cifX TCP/IP server must be 
started. The cifX TCP/IP server allows the remote access to the device via 
a TCP/IP connection. 
 

 
Note: An exe file for the cifXTCP/IP server is provided on the product CD 
in the Tools directory. 

 

Via the TCP/IP interface of the device or of the remote PC, the device is 
configured or diagnosis is performed. 
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3.2.4.4 Driver Parameters for netX Driver - TCP/IP Connection 

The settings of the driver parameters for the TCP/IP connection are made 
via the netX Driver / TCP Connection configuration dialog. 

 Open the TCP Connection dialog via navigation area Settings > 
Driver > netX Driver.  

 The dialog netX Driver is displayed: 

 Select TCP Connection. 

 
Figure 11: netX Driver > TCP Connection  

 
 
 
 
 

Parameter Meaning Range of Value / Value 
Enable TCP Connector 
(Restart of ODM 
required) 

checked: The netX Driver can communicate via the TCP/IP 
interface. 
unchecked: The netX Driver can not communicate via the 
TCP/IP interface. 
If the check mark for Enable TCP Connector is set or 
removed, then the ODM server must be restarted1, to make 
the new setting valid. 
_______ 
1 Restart the ODM server via the ODMV3 Tray Application: 

-In the foot line click to  using the right mouse key.  

- In the context menu select Service > Start. 

checked,  
unchecked; 
Default: 
unchecked 

Select IP Range Via Select IP Range already created IP ranges can be 
selected. 

Via  an additional IP range can be added. 

Via  an IP range can be deleted. 

 

Scan Timeout [ms] With the scan timeout can be set, how long to wait for a 
response during a connection is established. 

10 … 10000 [ms]; 
Default: 100 ms 
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Parameter Meaning Range of Value / Value 
IP Range Configuration 
Disable IP Range checked: No connection. 

unchecked: The netX Driver tries to establish a connection 
using the configured TCP/IP interface. 

checked,  
unchecked (Default) 

IP Address (left) Enter the IP address of the device, (if Use IP Range is not 
checked). 
Enter the start address of the IP scanning range, (if Use IP 
Range is checked). 

valid IP address; 
Default: 192.168.1.1 

Use IP Range checked: An IP address range is used. 
unchecked: Only one IP address is used. 

checked,  
unchecked; 
Default: 
unchecked 

IP Address (right) Enter the ending address of the IP scanning range, (only if 
Use IP Range is checked). 

valid IP address; 
Default: 0.0.0.0 

Address Count Displays the scanning range address count, depending on 
the selected IP-start or IP-end address. (For this read the 
note given below.) 

recommended: 10  

TCP Port Identifies the endpoint of a logical connection or addresses a 
specific endpoint on the device or PC. 

0 - 65535; 
Default Hilscher device: 
50111 

Send Timeout [ms] Maximum time before the transfer of the transmission data is 
canceled, when the send process fails, for example, because 
of the transfer buffer is full.  

100 … 60.000 [ms]; 
Default (TCP/IP): 1000 
ms 

Reset Timeout [ms] Maximum time for a device reset, including the re-
initialization of the physical interface used for the 
communication. 

100 … 60.000 [ms]; 
Default (TCP/IP): 2000 
ms 

Keep Alive Timeout 
[ms] 

The "Keep Alive" mechanism is used to monitor whether the 
connection to the device is active. Connection errors are 
detected using a periodic heartbeat mechanism. The 
heartbeat mechanism is initiated after the set time has 
elapsed, if the communication has failed. 

100 … 60.000 [ms]; 
Default (TCP/IP): 2000 
ms 

Restore Resets all settings in the configuration dialog to the default 
values. 

 

Save Saving all settings made in the configuration dialog netX 
Driver > Save TCP/IP Connection, i. e. only for the selected 
connection type. 

 

Save All Saving all settings made in the configuration dialog netX 
Driver, i. e. for all connection types. 

 

Table 12: Parameters netX Driver > TCP Connection 

 

 

Note: Do not use large IP ranges in combination with a low scan timeout. Microsoft 
introduced in Windows® XP SP2 a limit of concurrent half-open outbound 
TCP/IPconnections (connection attempts) to slow the spread of virus and malware from 
system to system. This limit makes it impossible to have more than 10 concurrent half-
open outbound connections. Every further connection attempt is put in a queue and 
forced to wait. Due to this limitation a large IP range used in combination with a low scan 
timeout could prevent the connection establishment to a device. 

 

 

 



Settings 35/113 

DTM for Hilscher CANopen Slave device | Configuration of Hilscher Slave Devices  
DOC091002OI04EN | Revision 4 | English | 2010-10 | Released | Public  © Hilscher, 2009-2010 

3.3 Device Assignment 
 

 
Note: In the Device Assignment you first must assign the CANopen 
Slave device to the CANopen Slave DTM by checking the check box. This 
is essential to establish an online connection from the CANopen Slave 
DTM to the CANopen Slave device later, as described in section 
Connecting/Disconnecting Device on page 84. 

 
 

Therefore in the Device Assignment dialog pane you scan for the 
CANopen Slave device and select it.  

If the device did not get a firmware or shall get a new firmware: 

1. first you scan for the device/s (with or without firmware) and select 
it/them,  

2. then you download a firmware to the device and 

3. subsequently you scan for the device/s (with firmware) once more and 
select it/them again. 
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3.3.1 Scanning for Devices 
1. Select Settings > Device Assignment in the navigation area. 

 The dialog pane Device Assignment is displayed. 

 
Figure 12: Device Assignment - detected Devices (* The name of the device class is 
displayed.) – Example for a device without firmware 

2. Select the list box entry suitable only. 

3. Select the Scan button, to start the scanning process. 

 Under Device Selection all devices are displayed, which can be 
connected to the CANopen Slave DTM via the preselected driver. 

 

 
Note: For devices, which have been found via the cifX Device Driver in 
the column Access path the indication …\cifX[0toN]_SYS is displayed. 
This is correct, as long as a device did not get a firmware. After the 
firmware download has been completed, in the column Access path the 
indication …\cifX[0toN]_Ch[0to3] is displayed. 
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Parameter Meaning Range of Value / 
Value 

Device selection Selecting suitable only or all devices. suitable only, all 

Device Device class of the CANopen Master Devices.  

Hardware Port 
0/1/2/3 

Shows, which hardware is assigned to which communication 
interface. 

 

Slot number Shows the Slot Number (Card ID) preset at the cifX card via 
the Rotary Switch Slot Number (Card ID). 
The indication n/a means, that no Slot-Nummer (Karten-ID) 
exists. This occurs, if the cifX card is not equipped with a 
Rotary Switch Slot Number (Card ID) or for cifX cards 
equipped with a Rotary Switch Slot Number (Card ID), if the 
rotary switch is set to the value 0 (zero). 

1 to 9, 
n/a 
 

Serial number Serial number of the device  

Driver Name of the driver  

Channel Protocol Shows, which firmware is loaded to which device channel. 
The data for the used channel consists of the protocol class 
and the communication class. 
a.) For devices without firmware: Undefined Undefined, 
b.) For devices with firmware: Protocol name corresponding 
to the used Firmware 

 

Access path 
(under Device 
selection last 
column on the 
right) 

Depending on the used driver in the column Access path 
different data to the device are displayed. 
For the cifX Device Driver the following data are displayed:  
a.) For devices without firmware: …\cifX[0toN]_SYS, 
b.) For devices with firmware: …\cifX[0toN]_Ch[0to3]. 
cifX[0toN] = Board number 0 to N 
Ch[0to3] = Channel number 0 to 3 

Depending on the 
device and on the 
driver:  
board or channel 
number, IP address 
or COM interface 

Access path  
(at the lower side 
of the dialog 
pane) 

If under Device selection the check box for a device is 
checked, under Access path (at the lower side of the dialog 
pane) the driver identification or depending on the used driver 
additional data to the device. 
For the cifX Device Driver the following data are displayed:  
a.) For devices without firmware: …\cifX[0toN]_SYS, 
b.) For devices with firmware: …\cifX[0toN]_Ch[0to3]. 
cifX[0toN] = Board number 0 to N 
Ch[0to3] = Channel number 0 to 3 

driver identification 
(ID) 
depending on the 
device and on the 
driver:  
board or channel 
number, IP address 
or COM interface 

Table 13: Parameters of the Device Assignment 
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3.3.1.1 Scanning for all Devices or for suitable only 

all 
1. In the Device Assignment pane select the list box entry all. 
2. Select the Scan button, to start the scanning process. 

 
Figure 13: Device Assignment - detected Devices (* The name of the device class is 
displayed.) Example for Devices without Firmware 

 Under Device Selection all devices are displayed, which are attainable 
in the network and which can be connected to a single DTM each via 
the preselected drivers. 

 

 
Note: During a subsequent firmware download in the selection window 
Select Firmware File all files from the selected folder are displayed, 
under Files of Type „All Files (*.*)“ is displayed and the check box 
Validate the selected firmware file. is unchecked. 

 
 

suitable only 
1. In the Device Assignment pane select the list box entry suitable only. 

2. Select the Scan button, to start the scanning process. 

 Under Device Selection all devices are displayed, which can be 
connected to the CANopen Slave DTM via the preselected drivers. 

 

 
Note: During a subsequent firmware download in the selection window 
Select Firmware File only firmware files from the selected folder are 
displayed, under Files of Type „Firmware Files (*.nxm)“ or „Firmware 
Files (*.nxf)“ is displayed and the check box Validate the selected 
firmware file. is checked. 
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3.3.2 Selecting the Device (with or without firmware) 
 

 
Note: A connection with the CANopen Slave DTM can only be 
established with one CANopen Slave device. 

 

To select the physical CANopen Slave device (with or without firmware): 

1. In the Device Assignment pane in the selection list Device selection 
check the check box for the device. 

 
Figure 14: Device Assignment - Selecting the Device (* The name of the device class is 
displayed.) – Example for a device without firmware / one Device is selected  

 Under Access path (below in the dialog pane) the access path to the 
device, e. g. the driver identification, or depending on the used driver 
additional access data of the device are displayed. 

2. Select the Apply button, to apply the selection. 
 

 
Note: Before an online connection from the CANopen Slave DTM to the 
CANopen Slave device can be established, a firmware must be loaded to 
the device and the device must be selected once more. 

 
 

 

For further information refer to section Firmware Download on page 42 or 
to section Selecting the Device once more (with Firmware) on page 40. 
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3.3.3 Selecting the Device once more (with Firmware) 
To select the CANopen Slave device (with firmware) once more, proceed 
as described hereafter: 

all 
1. In the pane Device Assignment select the list box entry all. 
2. Select the button Scan. 

 Under Device Selection all devices are displayed, which are attainable 
in the network and which can be connected to a DTM via the 
preselected drivers. 

3. In the Device Assignment pane in the selection list Device selection 
check the check box for the device. 

 
Figure 15: Device Assignment - Selecting the Device (* The name of the device class is 
displayed.) – Example for Devices with and without Firmware / one Device is selected 

 

 

Note: After the firmware download has been completed, for the devices which have been 
detected via the cifX Device Driver the following data are displayed:  
- In the column Channel Protocol: the data for the firmware for the used channel  
- In the column Access path or under Access path (below in the dialog pane):  
 the data: …\cifX[0toN]_Ch[0to3]. 
 cifX[0toN] = board number 0 to N  
 Ch[0to3] = channel number 0 to 3 

 

4. Select the Apply button, to apply the selection.  

5. Or select the OK button, to apply the selection and to close the DTM 
interface dialog.  

6. Connect the DTM to the device using the context menu (right mouse 
click). 
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Or: 

suitable only 
1. In the pane Device Assignment select the list box entry suitable only. 

2. Select the button Scan. 

 Under Device Selection all devices are displayed, which can be 
connected to the CANopen Slave DTM via the preselected drivers. 

3. In the Device Assignment pane in the selection list Device selection 
check the check box for the device. 

 
Figure 16: Device Assignment - Selecting the Device (* The name of the device class is 
displayed.) – Example for a device with firmware / one Device is selected 

 

 

Note: After the firmware download has been completed, for the devices which have been 
detected via the cifX Device Driver the following data are displayed:  
- In the column Channel Protocol: the data for the firmware for the used channel 
- In the column Access path or under Access path (below in the dialog pane):  
 the data: …\cifX[0toN]_Ch[0to3]. 
 cifX[0toN] = board number 0 to N  
 Ch[0to3] = channel number 0 to 3 

 

4. Select the Apply button, to apply the selection.  

5. Or select the OK button, to apply the selection and to close the DTM 
interface dialog.  

6. Connect the DTM to the device using the context menu (right mouse 
click). 

 

 

For further information how to establish an online connection from the 
CANopen Slave DTM to the CANopen Slave device, refer to section 
Connecting/Disconnecting Device on page 84. 
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3.4 Firmware Download 
Using the Firmware Download dialog a firmware can be transferred to the 
device.  
 

 
CAUTION! The firmware download  
- Stops the bus communication, 
- erases the configuration data base and 
- overwrites the existing firmware in the device. 

To complete the update and to make the device operable again, please 
re-download the configuration when this operation has finished. 

 
 

 
Note: Prior to the firmware download, you must select the driver and the 
Slave device (with or without firmware). 

 
 

 

For further information refer to section Overview Settings on page 24. 

 

To load the firmware to the device: 

1. In the navigation area select Settings > Firmware Download.  

 The dialog Firmware-Download pane is displayed. 

 
Figure 17: Firmware Download 

 

Parameter Meaning 
Name Name of the Firmware 
Version Version and Build Version of the Firmware 
Browse… Button to select the firmware file. 
Download Button to download the firmware. 

Table 14: Parameter Firmware Download 

 

2. Select the button Browse. 

 The selection window Select Firmware File is displayed. 
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Figure 18: Selection Window Select Firmware File 

 

Parameter Meaning Range of Value / 
Value 

Files of Type „All Files (*.*)“, if before in the Device Assignment pane the 
list box entry all has been selected.  
„ Firmware Files (*.nxm)“ or Firmware Files (*.nxf), if before 
in the Device Assignment pane the list box entry suitable 
only has been selected. 

All Files (*.*), 
Firmware Files (*.nxm), 
Firmware Files (*.nxf) 

Recent folder Path of the recently opened folder  
Firmware As soon as the firmware file has been selected, under 

Firmware the name, the version and the build version as 
well as the device class for the selected firmware is 
displayed. 

Name, Version, Build 
Version, Device Class 
for the selected 
firmware 

Help Button, to open the online help of the DTM.  

Table 15: Parameters Select Firmware File 

 

 

Further descriptions to the selection window Select Firmware File are 
included in the context sensitive help (F1 key) of the Microsoft 
Corporation. 
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Note: After in the Device Assignment pane the list box entry all/suitable only has been 
set, during a subsequent firmware download in the selection window Select Firmware 
File the following data are displayed or set: 
(for list box entry ) all suitable only 
In the selection window 
Select Firmware File: 

all files from the 
selected folder 

only firmware files from the 
selected folder 

Under Files of Type*: „All Files (*.*)“ „Firmware Files (*.nxm)“, 
„Firmware Files (*.nxf)“ 

Validation: There is a restricted 
validation, if the 
selected firmware is 
applied for the 
download. 

A validation is made, if the 
firmware file is suitable for the 
CANopen Slave DTM. 

 

*These settings in the selection window Select Firmware File can also be changed 
manually. 

 

3. In the selection window mark the firmware file to be loaded using the 
mouse. 

 In the selection window under Firmware the name and the version of 
the firmware are displayed. 

4. In the selection window select the Open button. 

 A validation is made, if the selected firmware file is suitable for the 
CANopen Slave DTM. 

 In the dialog pane Firmware Download during the validation the button 
Download is grayed out. 

 The selection window is closed. 

5. In the dialog pane Firmware Download click to the Download button, 
to download the firmware. 

 

Firmware is not valid for the selected device 

 If a firmware file is selected, which is not valid for the assigned device, 
the request Select Firmware File is displayed. 

 
Figure 19: Request Select Firmware File - Example 

 Answer to the request with No. 
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Figure 20: Firmware Download – Download 

 The request Do you really want to download the firmware? is 
displayed. 

 
Figure 21: Firmware-Download – Question) 

4. Select the Yes button. 
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 During the download a progress bar is displayed, in the status line a 
clock / green hook symbol is displayed and the button Download is 
grayed out. 

 
Figure 22: Clock Symbol and Hook Symbol green 

 
Figure 23: Firmware Download - Progress Bar 

 If necessary, cancel the download via Cancel. 
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4 Configuration 
4.1 Overview Configuration 

Dialog Panes “Configuration” 
The table below gives an overview for the Configuration dialog panes 
descriptions: 
 

Section Subsection Page 
Configuration Overview Configuration 47 
 General Settings  48 
 Special Function Objects 50 
 Object Dictionary 52 
 Process Data Objects 56 
    PDO Properties 56 
     PDO Mapping 59 
 Address Table  61 

Table 16: Dialog Panes Configuration 

 

 
Figure 24: Navigation Area - Configuration 

 
 

 

Notice the descriptions in the section Overview Configuration Steps on 
page 18. 
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4.2 General Settings 
 

The dialog General Settings displays EDS file data: 

 
Figure 25: General Settings (Slave DTM at the Root-Line (Stand-Alone Slave)) 

 
 

 
Figure 26: General Settings (Slave DTM at the Master busline) 

 
 



Configuration 49/113 

DTM for Hilscher CANopen Slave device | Configuration of Hilscher Slave Devices  
DOC091002OI04EN | Revision 4 | English | 2010-10 | Released | Public  © Hilscher, 2009-2010 

 

Parameter Meaning Range of Values / 
Value 

Node ID The Node ID (address) is required to address the device at the 
bus and must be unique within the CANopen network. Therefore it 
is not allowed to use this number twice in the same network and 
must match with the set Node address of the device. Otherwise it 
is not possible for the Master to build up a communication to this 
device. 
Slave DTM at the Root-Line (Stand-Alone Slave): 
The Node ID is set in the Slave DTM. 
Slave DTM at the Master busline):  
The Node ID is set in the Master DTM. 

1 … 127 

Baudrate Baud rate of CANopen connection  1 Mbaud, 
800 Kbaud, 
500 Kbaud, 
250 Kbaud, 
125 Kbaud, 
100 Kbaud, 
50 Kbaud, 
20 Kbaud, 
10 Kbaud, 
Default: 1 MBaud 

Device 
Profile and 
Device Type 

Because of the information of the Device Profile and the Device 
Type during start of communication, the Master can read out the 
Object 1000H from the Node and compare it with these data. 
Each CANopen Node has a mandatory Object 1000H, which must 
be present in the object directory. This object is named Device 
Type. The Device Type also includes the information about the 
Device Profile. 
The Master reads out the Object 1000H from the Node when 
starting up the CANopen bus and compares the entries, which are 
made in the two available fields Device Profile and Device Type. 
If the Device Profile and the Device Type do not match, the 
Master reports a parameterization error and does not establish a 
process data transfer to the Node. The verification can be also 
deactivated. 

Value read out from 
the EDS file 

Device 
Name, Hard 
and Software 
Version 

Displayed manufacturer data read out from the EDS file. Value read out from 
the EDS file 

Table 17: General Settings 
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4.3 Special Function Objects 
The dialogue Special Function Objects displays data of the 
synchronization, time stamp and emergency telegram, which are adjusted 
in the Master DTM and can not be edited here. These parameters can be 
changed via the CANopen Master DTM. 

 
Figure 27: Special Function Objects - Synchronization Telegram 

 

Parameter Meaning 
Synchroni- 
zation 
Message 

A PDO in CANopen can be configured in Event Driven mode or Cyclic 
Transmission. Both kinds of transmission types can be synchronized to 
a special synchronization message which is sent by the master in 
defined time intervals. 

SYNC COB-
ID [1005] 

The SYNC COB-ID is assigned by the master and cannot be edited 
here. It can be changed only by the CANopen Master DTM. 
The SYNC COB ID specifies the Identifier of the synchronization 
telegram. If the communication cycle period is not equal to zero, the 
transmission of the SYNC telegram is activated. 
If the field Device generates SYNC message is marked, the device 
produces the synchronisation message.  
If the field is 29-bit is marked, the 29-bit CAN ID of the CAN ID 
extended frame is valid. 

Communi- 
cation Cycle 
Period [1006] 

The Communication Cycle Period is assigned by the Master and 
cannot be edited here. It can be changed only by the CANopen Master 
DTM.  
The Communication Cycle Period specifies the time for the interval 
for the transmission the SYNC telegram. 

Synchronous 
Window 
Length 
[1007] 

The Synchronous Window Length is assigned by the master and 
cannot be edited here. It can be changed only by the CANopen Master 
DTM.  
The Synchronous Window Length specifies the length of the time 
window for synchronous PDO (process data objects).  

Table 18: Special Function Objects - Synchronization Telegram 
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Figure 28: Special Function Objects - Time Stamp Message 

 

Parameter Meaning 
Time Stamp 
Message 

For transmission of time data.  

TIME COB-ID 
[1012] 

The TIME COB ID is assigned by the Master and cannot be edited 
here. It can be changed only by the CANopen Master DTM.  
The TIME COB ID specifies the COB ID of the time stamp object.  
If the field Device consumes TIME message is marked, the device 
consumes the time stamp message.  
If the field Device produces TIME message is marked, the device 
produces the time stamp message.  
If the field is 29-bit is marked, the 29-bit CAN ID of the CAN ID 
extended frame is valid. 

Table 19:  Special Function Objects - Time Stamp Message 

 

 
Figure 29:  Special Function Objects - Emergency Message 

 

Parameter Meaning 
Emergency-
Telegram 

Emergency telegrams are sent by the Node when a node internal event 
occurs. 

EMCY COB-
ID [1014] 

If EMCY COB ID is activated, the CANopen Master can receive EMCY 
(Emergency) telegrams.  
The EMCY COB ID is assigned by the Master and cannot be edited 
here. It can be changed only by the CANopen Master DTM. The EMCY 
COB ID specifies the COB ID of the Emergency telegram.  
If the field is 29-bit is marked, the 29-bit CAN ID of the CAN ID 
extended frame is valid. 

Table 20:  Special Function Objects - Emergency Message 
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4.4 Object Dictionary 
The dialog Object Dictionary represents the object dictionary of the 
device. The display shows data read out from the EDS file.  

By means of filters in the table Object Configuration lists with configured 
and/or not configured objects can be displayed. A search function allows 
searching for a special object within the lists. 

 
Figure 30:  Object Dictionary - Filter Object Configuration 

 

Parameter Meaning Range of Values / 
Value 

Area Via Area a filtered object dictionary area can be selected, which is 
displayed in the table Object Configuration. 
If All is selected, in the table Object Configuration all objects are 
displayed, which are defined in the EDS file. 

All 
0x1000 … 0x11FF 
0x1200 … 0x 13FF 
0x1400 … 0x1FFF 
0x2000 … 0x5FFF 
0x6000 … 0x9FFF 
0xA000 … 0xFFFF 

Status Via Status it is possible to specify whether in the table Object 
Configuration all objects, only the configured objects or only the 
not configured objects of the selected range are to be displayed.  
Only the objects configured are relevant for data exchange.  

All 
configured 
not configured 

Object In the searching field Object the object index and/or the object 
index and subindex of a certain object can be entered.  
If the arrow button -> Go is clicked, the searched object (if 
available) is displayed in the upper line of the table Object 
Configuration.  
To enter an object index with subindex a dot is used.  
Example: 1400.01 

Min: 0000 
Max: FFFF 

Table 21:  Object Dictionary - Filter Object Configuration 
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The objects read out from the EDS file are displayed in the table Object 
Configuration. For better readability for objects with subindex a heading 
(object index without subindex) is displayed. 

 
Figure 31:  Object Dictionary - Object Configuration 
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The table Object Configuration the following parameter data are provided. 
 

Parameter Meaning Range of Values / Value 
The Objects activated in the configuration are checked. The 
Objects which are not configured are unchecked. 

configured (checked), 
not configured 
(unchecked) 

Symbol / 
Checkbox 

Description  

 The objects marked with a key symbol 
can not be enabled or disabled for the 
configuration in the Object Directory 
dialog, but they can be added or 
removed from the configuration 
elsewhere in the user interface. 

 

 Objects activated in the configuration configured 
(checkbox locked) 

 Objects which are not activated in the 
configuration  

not configured  
(checkbox locked) 

 Objects activated in the configuration configured 

Configure 

 Objects which are not activated in the 
configuration 

not configured 

Index.Sub-
index 

All objects are addressed in the object index and the 
corresponding subindex, which are defined by the EDS file. 

Object index 
0x1000 … 0xFFFF 
Sub index 
0x00 … 0xFF 

Name Symbolic name of the object, which is defined by the EDS 
file. 

From EDS file 

Access Gives the access right of the object, which is defined by the 
EDS file. 

RO = read only  
(read)  
RW = read, write  
(read, write) 
WO = write only  
(write) 
CONST = constant 

Table 22:  Object Dictionary - Object Configuration 
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If in the table Object Configuration a line is clicked by the cursor, the 
selected object, the current value, the default value, the data type, the 
minimum and maximum value are displayed in the fields below the table. 
By Display mode data display can be chosen in decimal or in hexadecimal 
mode. 

 
Figure 32:  Object Dictionary - Data selected Object 

 
Parameter Meaning Range of Value 
Selected 
Object 

In the display field Selected Object the object index, the subindex 
and the name of the selected object are indicated. These data are 
defined by the EDS file. 

 

Display Mode By selection of the Display Mode decimal and/or hexadecimal 
from the list field the values are displayed in decimal and/or 
hexadecimal mode.  

Hexadecimal  
Decimal 

Current 
Value 

In the input field Current Value a value can be assigned to the 
selected object.  

 

Default,  
Data Type, 
Min/Max 

In the display fields Default, Data Type and/or Min/Max the 
default value defined in the EDS file, the data type and/or the 
minimum and maximum value for the object is indicated.  
The values Min. and Max. are displayed in decimal mode by 
default. 

 

Table 23:  Object Dictionary - Data selected Object 
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4.5 Process Data Objects 
 

4.5.1 PDO Properties 
In the dialog PDO Properties the transmit and the receive PDOs are 
displayed. By the list field PDO Type the display can be changed from 
transmit PDOs (TPDO) to receive PDOs (RPDO) and vice versa.  

 
Figure 33:  Process Data Objects > PDO Properties - PDO Type 

The PDOs supported by the node are read out of the EDS file and 
displayed in the table PDO Configuration. The PDOs to be used for the 
communication can be specified i.e. configured in this window. 

 
Figure 34:  Process Data Objects > PDO Properties - PDO Configuration 
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Parameter Meaning Range of Values / Value 
PDO Type Filter function for the table PDO Configuration as 

- Transmit PDOs - TPDO = Transmit PDO  
or as  
- Receive PDOs - RPDO = Receive PDO. 
Transmit PDOs are sent by the node and are input data 
of the Master. 
Receive PDOs are output data of the Master and are 
received from the node. 

TPDO 
RPDO 

By activating/configuring of a PDO the PDO is used for 
the communication. The corresponding parameter 
values are part of the master configuration. During 
initialization the master transfers these parameters 
automatically into the node (default behavior).  
Note: The transmission of the parameters during the 
initialization phase can also be deactivated and/or 
become deactivated. I.e., the node uses parameters, 
which can be different from the parameters set here. 

configured (checked), 
not configured 
(unchecked) 

Checkbox Beschreibung  

 PDOs activated in the configuration 
The PDO is used for the communication. 

configured (checked)  
(checkbox locked) 

 PDOs activated in the configuration 
The PDO is used for the communication. 

configured (checked) 

Configure 

 PDOs which are not activated in the 
configuration 
The PDO is not used for the 
communication. 

not configured 
(unchecked) 

Index Object Index of the Process data object (PDO) 0x1400 … 0x15FF 
0x1800 … 0x19FF 

PDO Name Here RxPDO name and/or TxPDO name is indicated. 
These are defined in the EDS file. 

 

Table 24:  Process Data Objects > PDO Properties - PDO Configuration (examine) 
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Each process data object (PDO) has characteristics. These are displayed 
below the table. 

 
Figure 35:  Process Data Objects > PDO Properties - Data selected Object 

 

Parameter Meaning Range of Values / 
Value 

COB-ID In this field the CAN telegram identifier is displayed. 0 … 2047 
Trans-
mission Type 

For the transmit and/or receive PDOs different transmission 
types are possible. For a PDO in CANopen event driven, 
synchronous or asynchronous transmission can be 
configured. Transmission types can be synchronized to the 
synchronization message SYNC for example, which is sent 
by the master in defined time intervals.  
Synchronous means that the transmission of the PDO is 
related to the SYNC message.  
Asynchronous means that the transmission of the PDO is 
not related to the SYNC message and can be done at any 
time. 
Note: The support of the different transmission types is 
manufacturer and device dependent. For CANopen the 
support of individual and/or all transmission types is not 
required. Whether a device supports the desired 
transmission type, must be reread and/or examined in the 
technical manual of the used device, if necessary. 

0 … 255 

synchronous acyclic (0) 
synchronous cyclic (1-240) 
synchronous RTR (252) 
asynchronous RTR (253) 
Event driven, profile  
specific (254)  
Event driven, manufacturer 
specific (255) 

Trans-
mission 
Factor 

For synchronous TPDOs for the transmission type 
synchronous cyclic (1-240) another factor is to be set, to 
which SYNC telegram the data transmission refers.  
A transmission factor of 1 means that the message will be 
transferred with each SYNC telegram. A transmission factor 
of n means that the message will be transferred with each n-
th SYNC telegram. Asynchronous TPDOs are not 
transferred in a temporal correlation with a SYNC. 

 

Inhibit Time The Inhibit Timer (if supported) describes the time interval, 
which at least must be waited between the transmissions of 
two equal telegrams. Thus a too frequent transmission of the 
same telegram is suppressed. 

 

Event Timer The Event Timer (if supported) is possible only for TPDO 
transmission types 254 and 255. 
The expiration of the timer is used in the node as event, in 
order to send the TPDO. Manufacturer and/or device-
specifically also an application event can activate the 
sending of the TPDOs and reset the Event Timer. 

TPDO 254, 255 

Table 25:  Process Data Objects > PDO Properties - Data selected Object 
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4.5.2 PDO Mapping 
The dialog PDO Mapping permits to map the contents of a PDO.  

By use of the Filter PDO type field in the table Mappable Objects the 
receive PDOs (RPDO) or alternatively the transmit PDOs (TPDO) can be 
displayed. 

 
Figure 36:  Process Data Objects > PDO Mapping - Filter PDO Type 

In the list field Object Dictionary Area an object dictionary area can be 
preselected.  

 
Figure 37:  Process Data Objects > PDO Mapping - Object Dictionary Area 

The mappable objects appropriate to the preselection are listed in the table 
Mappable Objects. 

 
Figure 38:  Process Data Objects > PDO Mapping - Mappable Objects 

 

Parameter Meaning Range of Value 
Object 
Dictionary 
Area 

Object dictionary filter range. 
 

All 
0x1000 … 0x11FF 
0x1200 … 0x 13FF 
0x1400 … 0x1FFF 
0x2000 … 0x5FFF 
0x6000 … 0x9FFF 
0xA000 … 0xFFFF 

Mappable 
Objects 

List of the mappable objects. from EDS file 

Index. 
Subindex 

All objects are addressed in the object index and if necessary in 
the corresponding subindexes, which are defined by the EDS file.  
 

0x1000 … 0xFFFF 
as well as 
0 … 0xFF 

Parameter Name of the object from the EDS file.  
 

from EDS file 

Length The length of the PDOs in bytes.   
Access Gives the access rights of the process data objects, which are 

defined by the EDS file. 
rw = read, write 

Table 26:  Process Data Objects > PDO Mapping - Mappable Objects 
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In the list field PDO Contents Mapping for the PDO is selected, the PDO 
contents to be displayed. 

 
Figure 39:  Process Data Objects > PDO Mapping - Filter Mapped Objects 

The mapped objects appropriate to the preselection are listed in the table 
Mapped Objects. 

 
Figure 40:  Process Data Objects > PDO Mapping - Mapped Objects 

 

Parameter Meaning Range of Value 
PDO 
Contents 
Mapping for 

The PDO list field PDO Contents Mapping for contains all 
configured PDOs of the pane PDO Properties. The objects 
responsible for data exchange (max. 8 byte/PDO) are assigned to 
the PDOs. 

 

Filter PDO 
Type 

The mapping is proceeded separately for the RPDOs and/or the 
TPDOs.  

RPDO 
TPDO 

Mapped 
Objects 

The table Mapped Objects contains only configured objects and 
always corresponds in the PDO list field PDO Contents Mapping 
for selected PDOs.  

 

Index. 
Subindex 

All objects are addressed in the object index and if necessary in 
the corresponding subindexes, which are defined by the EDS file.  
 

0x1000 … 0xFFFF 
as well as 
0 … 0xFF 

Parameter Name of the parameter from the EDS file.  from EDS file 
Length The Length specifies the length of the PDOs.   

Table 27:  Process Data Objects > PDO Mapping - Mapped Objects 

 

To change the object sequence in the table Mapped Objects more easily, 
shifting buttons are available: move completely above, above, down and 
completely down. 
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4.6 Address Table 
The Address Table dialog pane shows a list of all addresses used in the 
process data image. The displayed addresses refer to the used CANopen. 

To configure the address data: 

 Select Configuration > Address Table in the navigation area. 

 
Figure 41: Configuration > Address Table 

4.6.1 Description of the Paramters 
 

 

Parameter Meaning 
PDO-Name Here RxPDO name and/or TxPDO name is indicated. These are 

defined in the EDS file. 
PDO-Idx Object Index of the Process data object (PDO) 
COB-ID COB-ID of the CAN telegram 
Obj. Idx  
Subidx 

All objects are addressed in the object index and if necessary in 
the corresponding subindexes, which are defined by the EDS 
file. 

Obj. Name Object Name  
Type Input data type or output data type 
Length Input data length or output data length of the PDOs in bytes 
Address Output data offset address or input data offset address 

Table 28: Address Table Pane Parameters - Inputs / Outputs 
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4.6.2 Display Mode 

Display Mode 
 Use the Display Mode drop-down list to select data display mode 

decimal or hexadecimal. 

 
Figure 42:  Configuration > Address Table - Display Mode 

 

Sort Addresses 
 To sort the address data by Name of Station or by Address, click on 

the respective column header.  
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5 Device Description 
5.1 About Device Description 

Dialog Panes “Device Description” 
The table below gives an overview for the Device Description dialog 
panes descriptions: 
Section Subsection Page 
Device Description Device  64  
 EDS 64 

Table 29:  Descriptions of the Dialog Panes Device Description 

 

 
Figure 43:  Navigation Area - Device Description 
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5.2 Device 
The Device Info dialog contains manufacturer information about the 
device, which is defined in the EDS file. The following information is 
indicated: 
 

Parameter Meaning 
Vendor name Vendor name of the device 
Product name Name of the device 
Ident. number Identification number of the device 
Revision Hardware reference 

Table 30:  General Device Information 

 

5.3 EDS 
The EDS Viewer shows the content of the EDS file in a text view. 

Under Filename the file directory path and the file name of the displayed 
EDS file is displayed. Find what offers a search feature to search for text 
contents within the text of the EDS file. 

In the EDS Viewer window on the left side, the line number is displayed for 
simple overview, the further entries show the EDS file in text format. 
 

Parameter Meaning 
Filename File directory path and the file name of the displayed EDS file. 
Find what Search feature to search for text contents within the text of the 

EDS file. 
Match case Search option 
Match whole word Search option 

Table 31: Device Description – EDS Viewer 
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6 Diagnosis 
6.1 Overview Diagnosis 

The dialog Diagnosis serves to diagnose the device behavior and 
communication errors. For diagnosis the device must reside in online state.  

The Extended Diagnosis helps to find communication and configuration 
errors, when default diagnosis fails.  
 

 

For further information to the Extended Diagnosis refer to section 
Overview Extended Diagnosis on page 70. 

 

Dialog Panes “Diagnosis” 
The table below gives an overview for the individual Diagnosis dialog 
panes descriptions: 
 

Section Page 
General Diagnosis  66 
Firmware Diagnosis 69 

Table 32:  Descriptions of the Diagnosis Panes 

 
 

 
Note: Accessing the Diagnosis panes of the CANopen Slave DTM 
requires an online connection from the CANopen Slave DTM to the 
CANopen Slave device. 

 
 

 

For further information, refer to section Connecting/Disconnecting Device 
on page 84. 

 

 
Figure 44:  Navigation Area - Diagnosis 
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6.2 General Diagnosis 
Information regarding the Device State and other general diagnosis 
parameters are displayed in the General Diagnosis dialog. 

 
Figure 45: General Diagnosis 
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LED Meaning Color State 

Device State 

 (green) COMMUNICATING Communicating Shows whether the CANopen device 
executes the network communication. 

 (gray) Not COMMUNICATING 

 (green) Configuration OK Run Shows whether the CANopen device has 
been configured correctly. 

 (gray) Configuration not OK 

 (yellow) Device READY Ready Shows whether the CANopen device has 
been started correctly. The CANopen device 
waits for a configuration.  (gray) Device not READY 

 (red) ERROR Error Shows whether the CANopen device records 
a device status error. For further information 
about the error characteristics and the 
number of counted errors refer to the 
extended diagnosis. 

 (gray) No ERROR 

Network State 

 (green) In OPERATION state Operate Shows whether the CANopen device is in 
data exchange. In a cyclic data exchange the 
input data or the output data of the CANopen 
Slave are transmitted to the CANopen 
Master. 

 (gray) Not  
in OPERATION state 

 (yellow) In IDLE state Idle Shows whether the CANopen device is in 
idle state. 

 (gray) Not in IDLE state 

 (red) In STOP state Stop Shows whether the CANopen device is in 
Stop state: There is no cyclic data exchange 
at the CANopen network. The CANopen 
device was stopped by the application 
program or it changed to the Stop state 
because of a bus error. 

 (gray) Not in STOP state 

 (yellow) In OFFLINE state Offline  The CANopen Slave is offline as long as it 
does not have a valid configuration. 

 (gray) Not in OFFLINE state 

Configuration State 

 (yellow) Configuration LOCKED Configuration 
locked 

Shows whether the CANopen device 
configuration is locked, to avoid the 
configuration data are typed over.  (gray) Configuration not 

LOCKED 

 (yellow) New Configuration 
pending 

New Configura-
tion pending 

Shows whether a new CANopen device 
configuration is available. 

 (gray) No new Configuration 
pending 

 (yellow) RESET required Reset required Shows whether a firmware reset is required 
as a new CANopen device configuration has 
been loaded into the device.  (gray) No RESET required 

 (green) Bus ON Bus ON Shows whether the bus communication was 
started or stopped. I. e., whether the device 
is active on the bus or no bus communication 
to the device is possible and no response 
telegrams are sent. 

 (gray) Bus OFF 

Table 33: Indication General Diagnosis 
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Parameter Meaning 
Communication Error Shows the message text of the communication error. If the 

cause of the current error is resolved, „ – “ is displayed. 
Watchdog time Shows the watchdog time in ms. 
Error Count This field holds the total number of errors detected since power-

up, respectively after reset. The protocol stack counts all sorts of 
errors in this field no matter if they were network related or 
caused internally. 

Table 34: Parameter General Diagnosis 
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6.3 Firmware Diagnosis 
In the dialog Firmware Diagnosis the actual task information of the 
firmware is displayed.  

Under Firmware or Version the name of the firmware and version 
(including the date) are indicated.  

 
Figure 46: Firmware Diagnosis (*The name of the Firmware is displayed.) 

 

Task Information: 
The table Task Information is listing the task information of the single 
firmware tasks. 
 

Column Meaning 
Task Task number  
Name of task Name of the task 
Version Version of the task 
Prio Priority of the task 
Description Description of the task 
Status Status of the task 

Table 35: Description Table Task Information 
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7 Extended Diagnosis 
7.1 Overview Extended Diagnosis 

The Extended Diagnosis of the CANopen Slave DTM helps to find 
communication and configuration errors. Therefore it contains a list of 
diagnosis structures as online counter, states and parameters. 

Dialog Panes “Extended Diagnosis” 
The table below gives an overview for the Extended Diagnosis dialog 
panes descriptions: 
 

Navigationsbereich  
CANopen-Slave 

Ordnername im 
Navigationsbereich 

Dialogfenster Handbuchseite 

RX-SYSTEM Task Information  71 
 IniBatch Status 72 
DPM_COMO_SMBX
  

Task Information  71 

DPM_COMO_RMBX
  

Task Information  71 

CANopen_DL Task Information  71 
CANOPEN_SLAVE Task Information  71 
 Common Diagnostic 73 
 Commands 74 
CANOPEN_APS Task Information  71 
 Slave configuration 76 

 

 Commands 77 

Table 36: Descriptions of the Dialog Panes Extended Diagnosis 

 
 

 
Note: Accessing the Extended Diagnosis dialog panes of the CANopen 
Slave DTM requires an online connection from the CANopen Slave DTM 
to the CANopen Slave device. 

 
 

 

For further information, refer to section Connecting/Disconnecting Device 
on page 84. 
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7.2 Task Information 

 
Figure 47: Extended Diagnosis > [Folder Name] > Task Information Example Display 

 

Name Description 
Identifier Identification number of the task 
Major version Task version, contains incompatible changes 
Minor version Task version, contains compatible changes 
Maximum packet size Maximum packet size, which the task sends 
Default Queue Queue handle, which is accessible via DPM by 

mailbox. 
UUID Unique user ID, 16 Byte indicator used for task 

identification and its affiliation e. g. to a stack (therein 
different identification data are coded in). 

Init result Error Code, 0= no Error 
The description of the error codes can be found in 
this manual or in the corresponding software 
reference manuals. 

Table 37: Extended Diagnosis > [Folder Name] > Task Information 
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7.3 IniBatch Status 

 
Figure 48: Extended Diagnosis > [Folder Name] > IniBatch Status Example Display 

 

Name Description 
Communication Channel Number of the communication channel used by the device. 
Current State 0 =Idle; 

1 =IniBatch packets in progress; 
2 =Retrying to send last packet; 
3 = Error 

IniBatch Result 0 = Ok; 
1 = No DBM file; 
2 = No Packet table; 
3 = No data set available;  
4 = Data set is shorter than packet length; 
5 = Packet Buffer is shorter than Packet length; 
6 = Invalid packet destination; 
7 = Logical queue not defined 
8 = Send packet failed; 
9 = Too many retries; 
10 = Error in confirmation packet status 

OpenDbm Result Error when opening the IniBatch data base 
Under "OpenDbm Result" the error code is typed in, when 
"IniBatch Result" == "No DBM file" (1) is. 

SendPacket Result Error when sending a packet 
Under "SendPacket Result" the error code is typed in, when 
"IniBatch Result" == “send packet failed" (8) is. 

Confirmation Result Confirmation error when sending packets 
Under "Confirmation Result" the packet specific error code 
from the ulSta is typed in, when "IniBatch Result " == "Error 
in confirmation packet status" (10) is. 

Last Packet Number Value depends by the communication system. 
Last Packet Command Value depends by the communication system. 
Last Packet Length Value depends by the communication system. 
Last Packet Destination Value depends by the communication system. 

Table 38: Extended Diagnosis > [Folder Name] > IniBatch Status 

 

The task status "Confirmation Result" is bus specific. The other task 
statuses are rcx-related error codes. 
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7.3.1 CANOPEN_SLAVE 
 

7.3.1.1 Common Diagnostic 

 
Figure 49: Extended Diagnosis > CANOPEN_SLAVE > Common Diagnostic 

 

Name Description 
Last received COB-ID Last received CAN-Message Header-ID 
CAN telegrams sent Number of sent CAN-Messages 
CAN telegrams received Number of received CAN-Messages 
Number of detected CAN errors Number of detected CAN errors 

Baud rate of CANopen connection  
Available Baud Rate: 

Baud rate 

1 MBaud 
800 KBaud 
500 KBaud 
250 KBaud 
125 KBaud 

100 KBaud 
50 KBaud 
20 KBaud 
10 KBaud 

Table 39: Extended Diagnosis > CANOPEN_SLAVE > Common Diagnostic 
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7.3.1.2 Commands 

 
Figure 50: Extended Diagnosis > CANOPEN_SLAVE > Commands 
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Name Description 
[Service] Diagnosis counter of the encapsulation layer. Indicates the services 

processed. (The services of the single packets are described in the API 
manual.) 

Get packet 
failed 

Number of errors during requesting a packet 

Send packet 
failed 

Number of errors during sending a packet 

Table 40: Extended Diagnosis > CANOPEN_SLAVE > Commands 
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7.3.2 CANOPEN_APS 
 

7.3.2.1 Slave configuration 

 
Figure 51: Extended Diagnosis > CANOPEN_APS > Slave Configuration 

 
 

Name Description 
Flags Bit0 

set: Configuration data base found 
not set: No configuration data base found 
Bit1 
set: Configuration by packets 
not set: No packets for configuration 

Database 
found 

Yes: Configuration data base found 
No: No configuration data base found 

Warmstart 
configuration 

Yes: Configuration by packets 
No: No packets for configuration 

Initialization 
state 

0  = Idle; 
1  = Send initialize request; 
2  = Wait for initialize confirmation; 
3  = Send register request;  
4  = Wait for register confirmation; 
5  = Send get buffer request; 
6  = Wait for get buffer confirmation; 
7  = Send bus parameter request; 
8  = Wait for bus parameter confirmation; 
9  = Complete; 
10  = Failed 

Initialization 
result 

Error code of the initialisation, 0 = no error 

Table 41: Extended Diagnosis > CANOPEN_APS > Slave Configuration 
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7.3.2.2 Commands 

 
Figure 52: Extended Diagnosis > CANOPEN_APS > Commands 

 

Name Description 
[Service] Diagnosis counter of the encapsulation layer. Indicates the services 

processed. (The services of the single packets are described in the API 
manual.) 

Get packet 
failed 

Number of errors during requesting a packet 

Send packet 
failed 

Number of errors during sending a packet 

Table 42: Extended Diagnosis > CANOPEN_APS > Commands 
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8 Tools 
8.1 Overview Tools 

Under Tools the Packet Monitor and the IO Monitor are provided for test 
and diagnosis purposes.  

Tools Panes 
The table below gives an overview for the individual Tools dialog panes 
descriptions: 
 

Section Page 
Packet Monitor  79 
IO Monitor 83 

Table 43: Descriptions of the Diagnosis Panes 

 

 
Note: Accessing the Tools panes of the CANopen Slave DTM requires 
an online connection from the CANopen Slave DTM to the CANopen 
Slave device. 

 
 

 

For further information, refer to section Connecting/Disconnecting Device 
on page 84. 

 

 
Figure 53: Navigation Area - Tools 
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8.2 Packet Monitor 
The Packet Monitor serves for test and diagnosis purposes.  

Data packets, i. e. messages are self-contained blocks of defined data 
length. The packets are used to communicate with the firmware and they 
are exchanged between the application (configuration software) and the 
firmware in the device. Packets can be sent once or cyclically to the 
connected device controlled by the user and packets received can be 
displayed. 

Data packets comprise from a Packet Header and the Send Data or from 
a Packet Header and the Receive Data. The packet header can be 
evaluated by the receiver of the packet and contain the sender and receiver 
address, the data length, an ID number, status and error messages and the 
command or response code. The minimum packet size amounts 40 Byte 
for the packet header. The sending and receiving data are added. 
 

 

For further information to the packet description refer to the Protocol API 
Manual.  

 Open the Packet Monitor via Tools > Packet Monitor. 

 
Figure 54: Packet Monitor 

Display Mode switches the representation of the send and reception data 
between decimal and hexadecimal. 

 Select Reset Counter to reset the packet counter. 
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8.2.1 Sending Packet 

 
Figure 55: Send > Packet Header and Send Data 

Packet Header 
Under Send > Packet Header the elements of the packet header of the 
sending packet are displayed, which is transmitted from the application 
(configuration software) to the device. The packet header of the sending 
packets contain the elements described in the following table. 
 

Element Description 
Dest Destination Queue Handle Contains the identifier of the receiver for the packet 

(destination task queue of the firmware).  
Src Source Queue Handle Contains the identifier of the sender of the packet 

(sending task).  
Dest ID Destination Queue Reference Contains an identifier for the receiver of unsolicited sent 

packets from the firmware to the application 
(configuration software).  

Src ID Source Queue Reference Contains an identifier of the sender.  
Len Packet Data Length (in Bytes) Length of the send respectively receive data. 
ID Packet Identification As 

Unique Number  
Identifies identical data packets among each other. 

State Status / Error Code Transmits status or error codes to the packet sender. 
Cmd Command / Response Code Command or respond code.  
Ext Extension Field for extensions (reserved). 
Rout Routing Information Internal value of the firmware. 

Table 44: Descriptions Packet Header 

 

 Under Dest select the receiver (destination task queue). 

 Under Cmd select the command identification (Request). 

Auto Increment ID is an increment for the identifier of the data packets 
and increments the ID by 1 for each newly sent packet. 
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Send Data 
 Under Send > Send data enter the send data of the packet, which shall 

be transmitted from the application (configuration software) to the 
mailbox of the device. The meaning of the transmitted data depends on 
the command or response code. 

Sending Packets once or cyclic 
 To send packet once, select Put packet. 
 To send packet cyclic, select Put cyclic. 

 
 

8.2.2 Receiving Packet 

 
Figure 56: Packet Header and Receive Data 

Packet Header 
Under Receive > Packet Header the elements of the packet header of the 
receiving packet are displayed, which are transmitted back from the device 
to the application (configuration software). The packet header of the 
receiving packets contain the elements described in the following table. 
 

Element Description 
Dest Destination Queue Handle Contains the identifier of the receiver for the packet 

(destination task queue of the firmware).  
Src Source Queue Handle Contains the identifier of the sender of the packet 

(sending task).  
Dest ID Destination Queue Reference Contains an identifier for the receiver of unsolicited sent 

packets from the firmware to the application 
(configuration software).  

Src ID Source Queue Reference Contains an identifier of the sender.  
Len Packet Data Length (in Bytes) Length of the send respectively receive data. 
ID Packet Identification As 

Unique Number  
Identifies identical data packets among each other. 

State Status / Error Code Transmits status or error codes to the packet sender. 
Cmd Command / Response Code Command or respond code.  
Ext Extension Field for extensions (reserved). 
Rout Routing Information Internal value of the firmware. 

Table 45: Descriptions Packet Header 
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Receive Data 
Under Receive > Receive Data the receiving data of the packet, which is 
transmitted back from the device to the application (configuration software) 
are displayed. 
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8.3 IO Monitor 
The IO Monitor serves for test and diagnosis purposes. It provides to view 
data of the process data image and to change output data easily. The 
display is always in a Byte manner.  
 

 
Note: Only change and write output data, if you know that no plant 
disturbances are caused by this. All output data written by the IO Monitor 
are transmitted at the bus and have effect on subordinate drives, IO etc. 

 

 
Figure 57: IO Monitor 

Columns switches the number of columns.  

Display Mode switches the representation of the input and output data 
between decimal and hexadecimal. 

Offset / Go moves the indication of the data to the entered offset value. 

Clear clears displayed error messages. 

 Enter the output value and select the button Update.  

 Always the data of the process image are displayed, also when these 
Bytes have not been reserved by the configuration.  
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9 Online Functions 
 

9.1 Connecting/Disconnecting Device 
 
 

 
Note: Several CANopen Slave DTM functions e. g. Diagnosis or for the 
configuration download in the FDT Framework require an online 
connection from the CANopen Slave DTM to the CANopen Slave device. 

 

Connecting Device 
The following steps are needed to establish a connection from the 
CANopen Slave DTM to a CANopen Slave device: 

Under Settings in the Driver pane: 

1. Select one or several driver/s. 

2. Configure the driver, if necessary. 

Under Settings in the Device Assignment pane: 

3. Scan for the device/s (with or without firmware). 

4. Select the device (with or without firmware) and apply the selection. 

Under Settings in the Firmware Download pane, if not yet a firmware was 
loaded to the device: 

5. Select and download the firmware. 

Under Settings in the Device Assignment pane, if not yet a firmware was 
loaded to the device: 

6. Scan for the device (with firmware) once more. 

7. Select the device (with firmware) once more. 
 

 

An overview of the descriptions for these steps you find in the section 
Overview Settings on page 24. 

 

8. In the DTM interface dialog select the OK button, to apply the selection 
and to close the DTM interface dialog. 

9. Put a right-click on the CANopen Slave device icon. 

10. Select the Connect command from the context menu. 

 The CANopen Slave device now is connected to the CANopen Slave 
DTM via an online connection. In the network view the device 
description at the device icon of the Slave is displayed with a green 
colored background. 
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Disconnecting Device 
To disconnect an online connection from the CANopen Slave device to the 
CANopen Slave DTM take the following steps: 

1. In the DTM interface dialog select the OK button, to close the DTM 
interface dialog. 

2. Right-click on the CANopen Slave device icon. 

3. Select the Disconnect command from the context menu. 

 Now the CANopen Slave device is disconnected from the CANopen 
Slave DTM.  
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9.2 Download Configuration 
 

 
Note: To download configuration parameter data to the CANopen Slave 
device an online connection from the CANopen Slave DTM to the 
CANopen Slave device is required.  

 
 

 

For further information, refer to section Connecting/Disconnecting Device 
on page 84. 

 

To transfer the configuration with the corresponding parameter data to the 
CANopen Slave device you download the data to it using the frame 
application of the configuration software. 
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10 Error Codes 
10.1 Error Code Definition 

For COM based application, like the ODM Server and ODM drivers, a 
common error definition is used, similar to the Microsoft Windows® 
HRESULT definition. 

Error Code Structure: 

COM Errors are HRESULTs, which are 32 bit values using the following 
layout: 

 3 3 2 2 2 2 2 2 2 2 2 2 1 1 1 1 1 1 1 1 1 1 

 1 0 9 8 7 6 5 4 3 2 1 0 9 8 7 6 5 4 3 2 1 0 9 8 7 6 5 4 3 2 1 0 

+---+-+-+-----------------------+-------------------------------+ 

|Sev|C|R|     Facility          |               Code            | 

+---+-+-+-----------------------+-------------------------------+ 

 

where 

Sev       - is the severity code: 

       00 - Success 

       01 - Informational 

       10 - Warning 

       11 - Error 

C         - is the Customer code flag 

R         - is a reserved bit 

Facility  - is the facility code 

Code      - is the facility's status code 

In this common error definition, several error code regions are already 
reserved by Windows® itself, the ODM and some other modules.  
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10.2 Overview Error Codes 
 
 

Overview Error Codes Range 

RCX General Task: 0xC02B0001 to 0xC02B4D52 

RCX Common Status & Errors Codes: 0x00000000 to 0xC002000C 

General Hardware Errors 
RCX Operating System 

RCX Status & Error Codes: 0x00000000 to 0xC0000008 

General ODM Error Codes: 0x8004C700 to 0x8004C761 ODM Server 

General ODM Driver Error Codes: 0x8004C7A0 to 0x8004C7C2 

ODM Drivers cifX Driver Specific ODM Error: 0x8004C001 to 0x8004C0A4 

Generic Error: 0x800A0001 bis 0x800A0017 

Generic Driver Error: 0x800B0001 bis0x800B0042 

cifX Device Driver  
and netX Driver 

Generic Device Error: 0x800C0010 bis0x800C0041 

CIFX API Transport: 0x800D0001 bis 0x800D0013 netX Driver 

CIFX API Transport Header State Error: 0x800E0001 bis 0x800E000B 

DBM ODM Error Codes: 0xC004C810 to 0xC004C878 

Table 46: Overview Error Codes and Ranges 

 
 

 

The fieldbus specific error codes are described in the manuals of the 
corresponding protocol tasks. 
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10.3 General Hardware Error Codes 

10.3.1 RCX General Task Errors 
 

Error Code (Definition) Value Description 
RCX_E_QUE_UNKNOWN 0xC02B0001 Unknown Queue 
RCX_E_QUE_INDEX_UNKNOWN 0xC02B0002 Unknown Queue Index 
RCX_E_TASK_UNKNOWN 0xC02B0003 Unknown Task 
RCX_E_TASK_INDEX_UNKNOWN 0xC02B0004 Unknown Task Index 
RCX_E_TASK_HANDLE_INVALID 0xC02B0005 Invalid Task Handle 
RCX_E_TASK_INFO_IDX_UNKNOWN 0xC02B0006 Unknown Index 
RCX_E_FILE_XFR_TYPE_INVALID 0xC02B0007 Invalid Transfer Type 
RCX_E_FILE_REQUEST_INCORRECT 0xC02B0008 Invalid File Request  
RCX_E_TASK_INVALID 0xC02B000E Invalid Task 
RCX_E_SEC_FAILED 0xC02B001D Security EEPROM Access Failed 
RCX_E_EEPROM_DISABLED 0xC02B001E EEPROM Disabled 
RCX_E_INVALID_EXT 0xC02B001F Invalid Extension 
RCX_E_SIZE_OUT_OF_RANGE 0xC02B0020 Block Size Out Of Range 
RCX_E_INVALID_CHANNEL 0xC02B0021 Invalid Channel 
RCX_E_INVALID_FILE_LEN 0xC02B0022 Invalid File Length 
RCX_E_INVALID_CHAR_FOUND 0xC02B0023 Invalid Character Found 
RCX_E_PACKET_OUT_OF_SEQ 0xC02B0024 Packet Out Of Sequence 
RCX_E_SEC_NOT_ALLOWED 0xC02B0025 Not Allowed In Current State 
RCX_E_SEC_INVALID_ZONE 0xC02B0026 Security EEPROM Invalid Zone 
RCX_E_SEC_EEPROM_NOT_AVAIL 0xC02B0028 Security EEPROM Eeprom Not Available 
RCX_E_SEC_INVALID_CHECKSUM 0xC02B0029 Security EEPROM Invalid Checksum 
RCX_E_SEC_ZONE_NOT_WRITEABLE 0xC02B002A Security EEPROM Zone Not Writeable 
RCX_E_SEC_READ_FAILED 0xC02B002B Security EEPROM Read Failed 
RCX_E_SEC_WRITE_FAILED 0xC02B002C Security EEPROM Write Failed 
RCX_E_SEC_ACCESS_DENIED 0xC02B002D Security EEPROM Access Denied 
RCX_E_SEC_EEPROM_EMULATED 0xC02B002E Security EEPROM Emulated 
RCX_E_INVALID_BLOCK 0xC02B0038 Invalid Block 
RCX_E_INVALID_STRUCT_NUMBER 0xC02B0039 Invalid Structure Number 
RCX_E_INVALID_CHECKSUM 0xC02B4352 Invalid Checksum 
RCX_E_CONFIG_LOCKED 0xC02B4B54 Configuration Locked 
RCX_E_SEC_ZONE_NOT_READABLE 0xC02B4D52 Security EEPROM Zone Not Readable 

Table 47: RCX General Task Errors 
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10.3.2 RCX Common Status & Errors Codes 
 

Error Code (Definition) Value Description 
RCX_S_OK 0x00000000 Success, Status Okay 
RCX_E_FAIL 0xC0000001 Fail 
RCX_E_UNEXPECTED 0xC0000002 Unexpected 
RCX_E_OUTOFMEMORY 0xC0000003 Out Of Memory 
RCX_E_UNKNOWN_COMMAND 0xC0000004 Unknown Command 
RCX_E_UNKNOWN_DESTINATION 0xC0000005 Unknown Destination 
RCX_E_UNKNOWN_DESTINATION_ID 0xC0000006 Unknown Destination ID 
RCX_E_INVALID_PACKET_LEN 0xC0000007 Invalid Packet Length 
RCX_E_INVALID_EXTENSION 0xC0000008 Invalid Extension 
RCX_E_INVALID_PARAMETER 0xC0000009 Invalid Parameter 
RCX_E_WATCHDOG_TIMEOUT 0xC000000C Watchdog Timeout 
RCX_E_INVALID_LIST_TYPE 0xC000000D Invalid List Type 
RCX_E_UNKNOWN_HANDLE 0xC000000E Unknown Handle 
RCX_E_PACKET_OUT_OF_SEQ 0xC000000F Out Of Sequence 
RCX_E_PACKET_OUT_OF_MEMORY 0xC0000010 Out Of Memory 
RCX_E_QUE_PACKETDONE 0xC0000011 Queue Packet Done 
RCX_E_QUE_SENDPACKET 0xC0000012 Queue Send Packet 
RCX_E_POOL_PACKET_GET 0xC0000013 Pool Packet Get 
RCX_E_POOL_GET_LOAD 0xC0000015 Pool Get Load 
RCX_E_REQUEST_RUNNING 0xC000001A Request Already Running 
RCX_E_INIT_FAULT 0xC0000100 Initialization Fault 
RCX_E_DATABASE_ACCESS_FAILED 0xC0000101 Database Access Failed 
RCX_E_NOT_CONFIGURED 0xC0000119 Not Configured 
RCX_E_CONFIGURATION_FAULT 0xC0000120 Configuration Fault 
RCX_E_INCONSISTENT_DATA_SET 0xC0000121 Inconsistent Data Set 
RCX_E_DATA_SET_MISMATCH 0xC0000122 Data Set Mismatch 
RCX_E_INSUFFICIENT_LICENSE 0xC0000123 Insufficient License 
RCX_E_PARAMETER_ERROR 0xC0000124 Parameter Error 
RCX_E_INVALID_NETWORK_ADDRESS 0xC0000125 Invalid Network Address 
RCX_E_NO_SECURITY_MEMORY 0xC0000126 No Security Memory 
RCX_E_NETWORK_FAULT 0xC0000140 Network Fault 
RCX_E_CONNECTION_CLOSED 0xC0000141 Connection Closed 
RCX_E_CONNECTION_TIMEOUT 0xC0000142 Connection Timeout 
RCX_E_LONELY_NETWORK 0xC0000143 Lonely Network 
RCX_E_DUPLICATE_NODE 0xC0000144 Duplicate Node 
RCX_E_CABLE_DISCONNECT 0xC0000145 Cable Disconnected 
RCX_E_BUS_OFF 0xC0000180 Network Node Bus Off 
RCX_E_CONFIG_LOCKED 0xC0000181 Configuration Locked 
RCX_E_APPLICATION_NOT_READY 0xC0000182 Application Not Ready 
RCX_E_TIMER_APPL_PACKET_SENT 0xC002000C Timer App Packet Sent 

Table 48: RCX Common Status & Errors Codes 
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10.3.3 RCX Status & Error Codes 
 

Error Code (Definition) Value Description 
RCX_S_OK  0x00000000 SUCCESS, STATUS OKAY  
RCX_S_QUE_UNKNOWN  0xC02B0001 UNKNOWN QUEUE  
RCX_S_QUE_INDEX_UNKNOWN  0xC02B0002 UNKNOWN QUEUE INDEX 
RCX_S_TASK_UNKNOWN 0xC02B0003 UNKNOWN TASK  
RCX_S_TASK_INDEX_UNKNOWN 0xC02B0004 UNKNOWN TASK INDEX  
RCX_S_TASK_HANDLE_INVALID 0xC02B0005 INVALID TASK HANDLE  
RCX_S_TASK_INFO_IDX_UNKNOWN 0xC02B0006 UNKNOWN INDEX  
RCX_S_FILE_XFR_TYPE_INVALID 0xC02B0007 INVALID TRANSFER TYPE  
RCX_S_FILE_REQUEST_INCORRECT 0xC02B0008 INVALID FILE REQUEST  
RCX_S_UNKNOWN_DESTINATION 0xC0000005 UNKNOWN DESTINATION  
RCX_S_UNKNOWN_DESTINATION_ID 0xC0000006 UNKNOWN DESTINATION ID  
RCX_S_INVALID_LENGTH 0xC0000007 INVALID LENGTH  
RCX_S_UNKNOWN_COMMAND 0xC0000004 UNKNOWN COMMAND  
RCX_S_INVALID_EXTENSION 0xC0000008 INVALID EXTENSION  

Table 49: RCX Status & Error Codes 

 

10.3.3.1 RCX Status & Error Codes Slave State 
 

Error Code (Definition) Value Description 
RCX_SLAVE_STATE_UNDEFINED 0x00000000 UNDEFINED 
RCX_SLAVE_STATE_OK 0x00000001 OK 
RCX_SLAVE_STATE_FAILED 0x00000002 FAILED (at least one slave) 

Table 50: RCX Status & Error Codes Slave State 
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10.4 ODM Error Codes 
 

10.4.1 General ODM Error Codes 
 

Error Code (Definition) Value Description 

CODM3_E_INTERNALERROR 0x8004C700 Internal ODM Error 

ODM3_E_DESCRIPTION_NOTFOUND 0x8004C701 Description not found in ODM database 

CODM3_E_WRITEREGISTRY 0x8004C710 Error writing to the registry 

CODM3_E_BAD_REGULAR_EXPRESSION 0x8004C711 Invalid regular expression 

CODM3_E_COMCATEGORIE_MANAGER_ 
FAILED 

0x8004C712 Component Category Manager could not 
be instantiated 

CODM3_E_COMCATEGORIE_ENUMERATION_
FAILED 

0x8004C713 Driver could not be enumerated by the 
Category Manager 

CODM3_E_CREATE_LOCAL_BUFFER 0x8004C714 Error creating local buffers 

CODM3_E_UNKNOWNHANDLE 0x8004C715 Unknown handle 

CODM3_E_QUEUE_LIMIT_REACHED 0x8004C717 Queue size limit for connection reached 

CODM3_E_DATASIZE_ZERO 0x8004C718 Zero data length passed 

CODM3_E_INVALID_DATA 0x8004C719 Invalid data content 

CODM3_E_INVALID_MODE 0x8004C71A Invalid mode 

CODM3_E_DATABASE_READ 0x8004C71B Error reading database 

CODM3_E_CREATE_DEVICE_THREAD 0x8004C750 Error creating device thread 

CODM3_E_CREATE_DEVICE_THREAD_STOP_
EVENT 

0x8004C751 Error creating device thread stop event 

CODM3_E_CLIENT_NOT_REGISTERED 0x8004C752 Client is not registered at the ODM 

CODM3_E_NO_MORE_CLIENTS 0x8004C753 Maximum number of clients reached 

CODM3_E_MAX_CLIENT_CONNECTIONS_ 
REACHED 

0x8004C754 Maximum number of client connections 
reached 

CODM3_E_ENTRY_NOT_FOUND 0x8004C755 Driver/device not found 

CODM3_E_DRIVER_NOT_FOUND 0x8004C757 The requested driver is unknown to the 
ODM 

CODM3_E_DEVICE_ALREADY_LOCKED 0x8004C758 Device is locked by another process 

CODM3_E_DEVICE_UNLOCKED_FAILED 0x8004C759 Device could not be unlocked, lock was 
set by another process 

CODM3_E_DEVICE_LOCK_NECCESSARY 0x8004C75A Operation requires a device lock to be set 

CODM3_E_DEVICE_SUBSCRIPTIONLIMIT 0x8004C75B Maximum number of servers registered for 
this device reached 

CODM3_E_DEVICE_NOTSUBSCRIBED 0x8004C75C Process is not registered as a server on 
this device 

CODM3_E_DEVICE_NO_MESSAGE 0x8004C75D No message available 

CODM3_E_TRANSFERTIMEOUT 0x8004C760 Message transfer timeout 

CODM3_E_MESSAGE_INSERVICE 0x8004C761 Message in service 

Table 51: ODM Error Codes - General ODM Error Codes 
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10.4.2 General ODM Driver Error Codes 
 

Error Code (Definition) Value Description 
CODM3_E_DRV_OPEN_DEVICE 0x8004C7A0 Packet type unsupported by driver 
CODM3_E_DRV_INVALID_IDENTIFIER 0x8004C7A1 Invalid device identifier 
CODM3_E_DRV_DEVICE_PARAMETERS_ 
MISMATCH 

0x8004C7A3 Parameters differ from requested device 

CODM3_E_DRV_BROWSE_NO_DEVICES 0x8004C7A4 No devices found 
CODM3_E_DRV_CREATE_DEVICE_INST 0x8004C7A5 Device instance could not be created 
CODM3_E_DRV_DEVICE_NOMORE_TX 0x8004C7A6 Device connection limit reached 
CODM3_E_DRV_DEVICE_DUPLICATE_TX 0x8004C7A7 Duplicate transmitter ID 
CODM3_E_DRV_DEVICE_NOT_CONFIGURED 0x8004C7A8 Device is not configured 
CODM3_E_DRV_DEVICE_COMMUNICATION 0x8004C7A9 Device communication error 
CODM3_E_DRV_DEVICE_NO_MESSAGE 0x8004C7AA No message available 
CODM3_E_DRV_DEVICE_NOT_READY 0x8004C7AB Device not ready 
CODM3_E_DRV_INVALIDCONFIGURATION 0x8004C7AC Invalid driver configuration 
CODM3_E_DRV_DLINVALIDMODE 0x8004C7C0 Invalid download mode 
CODM3_E_DRV_DLINPROGRESS 0x8004C7C1 Download is active 
CODM3_E_DRV_ULINPROGRESS 0x8004C7C2 Upload is active 

Table 52: ODM Error Codes - General ODM Driver Error Codess 
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10.4.3 cifX Driver Specific ODM Error Codes 
 

 

cifX Driver Specific ODM Error Codes 
Error Code (Definition) Value Description 
DRV_E_BOARD_NOT_INITIALIZED 0x8004C001 DRIVER Board not initialized 
DRV_E_INIT_STATE_ERROR 0x8004C002 DRIVER Error in internal init state 
DRV_E_READ_STATE_ERROR 0x8004C003 DRIVER Error in internal read state 
DRV_E_CMD_ACTIVE 0x8004C004 DRIVER Command on this channel is 

active 
DRV_E_PARAMETER_UNKNOWN 0x8004C005 DRIVER Unknown parameter in function 
DRV_E_WRONG_DRIVER_VERSION 0x8004C006 DRIVER Version is incompatible with DLL 
DRV_E_PCI_SET_CONFIG_MODE 0x8004C007 DRIVER Error during PCI set configuration 

mode 
DRV_E_PCI_READ_DPM_LENGTH 0x8004C008 DRIVER Could not read PCI dual port 

memory length 
DRV_E_PCI_SET_RUN_MODE 0x8004C009 DRIVER Error during PCI set run mode 
DRV_E_DEV_DPM_ACCESS_ERROR 0x8004C00A DEVICE Dual port ram not 

accessable(board not found) 
DRV_E_DEV_NOT_READY 0x8004C00B DEVICE Not ready (ready flag failed) 
DRV_E_DEV_NOT_RUNNING 0x8004C00C DEVICE Not running (running flag failed) 
DRV_E_DEV_WATCHDOG_FAILED 0x8004C00D DEVICE Watchdog test failed 
DRV_E_DEV_OS_VERSION_ERROR 0x8004C00E DEVICE Signals wrong OS version 
DRV_E_DEV_SYSERR 0x8004C00F DEVICE Error in dual port flags 
DRV_E_DEV_MAILBOX_FULL 0x8004C010 DEVICE Send mailbox is full 
DRV_E_DEV_PUT_TIMEOUT 0x8004C011 DEVICE PutMessage timeout 
DRV_E_DEV_GET_TIMEOUT 0x8004C012 DEVICE GetMessage timeout 
DRV_E_DEV_GET_NO_MESSAGE 0x8004C013 DEVICE No message available 
DRV_E_DEV_RESET_TIMEOUT 0x8004C014 DEVICE RESET command timeout 
DRV_E_DEV_NO_COM_FLAG 0x8004C015 DEVICE COM-flag not set. Check if Bus is 

running 
DRV_E_DEV_EXCHANGE_FAILED 0x8004C016 DEVICE I/O data exchange failed 
DRV_E_DEV_EXCHANGE_TIMEOUT 0x8004C017 DEVICE I/O data exchange timeout 
DRV_E_DEV_COM_MODE_UNKNOWN 0x8004C018 DEVICE I/O data mode unknown 
DRV_E_DEV_FUNCTION_FAILED 0x8004C019 DEVICE Function call failed 
DRV_E_DEV_DPMSIZE_MISMATCH 0x8004C01A DEVICE DPM size differs from 

configuration 
DRV_E_DEV_STATE_MODE_UNKNOWN 0x8004C01B DEVICE State mode unknown 
DRV_E_DEV_HW_PORT_IS_USED 0x8004C01C DEVICE Output port already in use 
DRV_E_USR_OPEN_ERROR 0x8004C01E USER Driver not opened (device driver not 

loaded) 
DRV_E_USR_INIT_DRV_ERROR 0x8004C01F USER Can't connect to device 
DRV_E_USR_NOT_INITIALIZED 0x8004C020 USER Board not initialized (DevInitBoard 

not called) 
DRV_E_USR_COMM_ERR 0x8004C021 USER IOCTRL function failed 
DRV_E_USR_DEV_NUMBER_INVALID 0x8004C022 USER Parameter DeviceNumber invalid 
DRV_E_USR_INFO_AREA_INVALID 0x8004C023 USER Parameter InfoArea unknown 
DRV_E_USR_NUMBER_INVALID 0x8004C024 USER Parameter Number invalid 
DRV_E_USR_MODE_INVALID 0x8004C025 USER Parameter Mode invalid 
DRV_E_USR_MSG_BUF_NULL_PTR 0x8004C026 USER NULL pointer assignment 
DRV_E_USR_MSG_BUF_TOO_SHORT 0x8004C027 USER Message buffer too small 
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cifX Driver Specific ODM Error Codes 
Error Code (Definition) Value Description 
DRV_E_USR_SIZE_INVALID 0x8004C028 USER Parameter Size invalid 
DRV_E_USR_SIZE_ZERO 0x8004C02A USER Parameter Size with zero length 
DRV_E_USR_SIZE_TOO_LONG 0x8004C02B USER Parameter Size too long 
DRV_E_USR_DEV_PTR_NULL 0x8004C02C USER Device address null pointer 
DRV_E_USR_BUF_PTR_NULL 0x8004C02D USER Pointer to buffer is a null pointer 
DRV_E_USR_SENDSIZE_TOO_LONG 0x8004C02E USER Parameter SendSize too large 
DRV_E_USR_RECVSIZE_TOO_LONG 0x8004C02F USER Parameter ReceiveSize too large 
DRV_E_USR_SENDBUF_PTR_NULL 0x8004C030 USER Pointer to send buffer is a null 

pointer 
DRV_E_USR_RECVBUF_PTR_NULL 0x8004C031 USER Pointer to receive buffer is a null 

pointer 
DRV_E_DMA_INSUFF_MEM 0x8004C032 DMA Memory allocation error 
DRV_E_DMA_TIMEOUT_CH4 0x8004C033 DMA Read I/O timeout 
DRV_E_DMA_TIMEOUT_CH5 0x8004C034 DMA Write I/O timeout 
DRV_E_DMA_TIMEOUT_CH6 0x8004C035 DMA PCI transfer timeout 
DRV_E_DMA_TIMEOUT_CH7 0x8004C036 DMA Download timeout 
DRV_E_DMA_DB_DOWN_FAIL 0x8004C037 DMA Database download failed 
DRV_E_DMA_FW_DOWN_FAIL 0x8004C038 DMA Firmware download failed 
DRV_E_CLEAR_DB_FAIL 0x8004C039 DMA Clear database on the device failed 
DRV_E_DEV_NO_VIRTUAL_MEM 0x8004C03C DMA USER Virtual memory not available 
DRV_E_DEV_UNMAP_VIRTUAL_MEM 0x8004C03D DMA USER Unmap virtual memory failed 
DRV_E_GENERAL_ERROR 0x8004C046 DRIVER General error 
DRV_E_DMA_ERROR 0x8004C047 DRIVER General DMA error 
DRV_E_WDG_IO_ERROR 0x8004C048 DRIVER I/O WatchDog failed 
DRV_E_WDG_DEV_ERROR 0x8004C049 DRIVER Device Watchdog failed 
DRV_E_USR_DRIVER_UNKNOWN 0x8004C050 USER Driver unknown 
DRV_E_USR_DEVICE_NAME_INVALID 0x8004C051 USER Device name invalid 
DRV_E_USR_DEVICE_NAME_UKNOWN 0x8004C052 USER Device name unknown 

DRV_E_USR_DEVICE_FUNC_NOTIMPL 0x8004C053 USER Device function not implemented 

DRV_E_USR_FILE_OPEN_FAILED 0x8004C064 USER File could not be opened 

DRV_E_USR_FILE_SIZE_ZERO 0x8004C065 USER File size zero 

DRV_E_USR_FILE_NO_MEMORY 0x8004C066 USER Not enough memory to load file 

DRV_E_USR_FILE_READ_FAILED 0x8004C067 USER File read failed 

DRV_E_USR_INVALID_FILETYPE 0x8004C068 USER File type invalid 

DRV_E_USR_FILENAME_INVALID 0x8004C069 USER Invalid filename 

DRV_E_FW_FILE_OPEN_FAILED 0x8004C06E USER Firmware file could not be opened 

DRV_E_FW_FILE_SIZE_ZERO 0x8004C06F USER Not enough memory to load 
firmware file 

DRV_E_FW_FILE_NO_MEMORY 0x8004C070 USER Not enough memory to load 
firmware file 

DRV_E_FW_FILE_READ_FAILED 0x8004C071 USER Firmware file read failed 

DRV_E_FW_INVALID_FILETYPE 0x8004C072 USER Firmware file type invalid 

DRV_E_FW_FILENAME_INVALID 0x8004C073 USER Firmware file name not valid 

DRV_E_FW_DOWNLOAD_ERROR 0x8004C074 USER Firmware file download error 

DRV_E_FW_FILENAME_NOT_FOUND 0x8004C075 USER Firmware file not found in the 
internal table 

DRV_E_FW_BOOTLOADER_ACTIVE 0x8004C076 USER Firmware file BOOTLOADER active 
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cifX Driver Specific ODM Error Codes 
Error Code (Definition) Value Description 
DRV_E_FW_NO_FILE_PATH 0x8004C077 USER Firmware file no file path 

DRV_E_CF_FILE_OPEN_FAILED 0x8004C078 USER Configuration file could not be 
opend 

DRV_E_CF_FILE_SIZE_ZERO 0x8004C079 USER Configuration file size zero 

DRV_E_CF_FILE_NO_MEMORY 0x8004C07A USER Not enough memory to load 
configuration file 

DRV_E_CF_FILE_READ_FAILED 0x8004C07B USER Configuration file read failed 

DRV_E_CF_INVALID_FILETYPE 0x8004C07C USER Configuration file type invalid 

DRV_E_CF_FILENAME_INVALID 0x8004C07D USER Configuration file name not valid 

DRV_E_CF_DOWNLOAD_ERROR 0x8004C07E USER Configuration file download error 

DRV_E_CF_FILE_NO_SEGMENT 0x8004C07F USER No flash segment in the 
configuration file 

DRV_E_CF_DIFFERS_FROM_DBM 0x8004C080 USER Configuration file differs from 
database 

DRV_E_DBM_SIZE_ZERO 0x8004C083 USER Database size zero 

DRV_E_DBM_NO_MEMORY 0x8004C084 USER Not enough memory to upload 
database 

DRV_E_DBM_READ_FAILED 0x8004C085 USER Database read failed 

DRV_E_DBM_NO_FLASH_SEGMENT 0x8004C086 USER Database segment unknown 

DEV_E_CF_INVALID_DESCRIPT_VERSION 0x8004C096 CONFIG Version of the descript table 
invalid 

DEV_E_CF_INVALID_INPUT_OFFSET 0x8004C097 CONFIG Input offset is invalid 

DEV_E_CF_NO_INPUT_SIZE 0x8004C098 CONFIG Input size is 0 

DEV_E_CF_MISMATCH_INPUT_SIZE 0x8004C099 CONFIG Input size does not match 
configuration 

DEV_E_CF_INVALID_OUTPUT_OFFSET 0x8004C09A CONFIG Invalid output offset 

DEV_E_CF_NO_OUTPUT_SIZE 0x8004C09B CONFIG Output size is 0 

DEV_E_CF_MISMATCH_OUTPUT_SIZE 0x8004C09C CONFIG Output size does not match 
configuration 

DEV_E_CF_STN_NOT_CONFIGURED 0x8004C09D CONFIG Station not configured 

DEV_E_CF_CANNOT_GET_STN_CONFIG 0x8004C09E CONFIG Cannot get the Station 
configuration 

DEV_E_CF_MODULE_DEF_MISSING 0x8004C09F CONFIG Module definition is missing 

DEV_E_CF_MISMATCH_EMPTY_SLOT 0x8004C0A0 CONFIG Empty slot mismatch 

DEV_E_CF_MISMATCH_INPUT_OFFSET 0x8004C0A1 CONFIG Input offset mismatch 

DEV_E_CF_MISMATCH_OUTPUT_OFFSET 0x8004C0A2 CONFIG Output offset mismatch 

DEV_E_CF_MISMATCH_DATA_TYPE 0x8004C0A3 CONFIG Data type mismatch 

DEV_E_CF_MODULE_DEF_MISSING_NO_SI 0x8004C0A4 CONFIG Module definition is missing,(no 
Slot/Idx) 

Table 53: cifX Driver Specific ODM Error Codes 
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10.5 Error Codes cifX Device Driver and netX Driver 
 

10.5.1 Generic Error Codes 
 
 

Error Code (Definition) Value Description 
CIFX_INVALID_POINTER  0x800A0001L Invalid pointer (NULL) passed to driver 
CIFX_INVALID_BOARD  0x800A0002L No board with the given nameindex 

available 
CIFX_INVALID_CHANNEL  0x800A0003L No channel with the given index 

available 
CIFX_INVALID_HANDLE 0x800A0004L Invalid handle passed to driver 
CIFX_INVALID_PARAMETER  0x800A0005L Invalid parameter 
CIFX_INVALID_COMMAND 0x800A0006L Invalid command 
CIFX_INVALID_BUFFERSIZE  0x800A0007L Invalid buffer size 
CIFX_INVALID_ACCESS_SIZE 0x800A0008L Invalid access size 
CIFX_FUNCTION_FAILED  0x800A0009L Function failed 
CIFX_FILE_OPEN_FAILED  0x800A000AL File could not be opened 
CIFX_FILE_SIZE_ZERO 0x800A000BL File size is zero 
CIFX_FILE_LOAD_INSUFF_MEM  0x800A000CL Insufficient memory to load file 
CIFX_FILE_CHECKSUM_ERROR  0x800A000DL File checksum compare failed 
CIFX_FILE_READ_ERROR  0x800A000EL Error reading from file 
CIFX_FILE_TYPE_INVALID  0x800A000FL Invalid file type 
CIFX_FILE_NAME_INVALID 0x800A0010L Invalid file name 
CIFX_FUNCTION_NOT_AVAILABLE 0x800A0011L Driver function not available 
CIFX_BUFFER_TOO_SHORT 0x800A0012L Given buffer is too short 
CIFX_MEMORY_MAPPING_FAILED  0x800A0013L Failed to map the memory 
CIFX_NO_MORE_ENTRIES 0x800A0014L No more entries available 
CIFX_CALLBACK_MODE_UNKNOWN  0x800A0015L Unkown callback handling mode 
CIFX_CALLBACK_CREATE_EVENT_FAILED  0x800A0016L Failed to create callback events 
CIFX_CALLBACK_CREATE_RECV_BUFFER  0x800A0017L Failed to create callback receive buffer 

Table 54: Generic Error Codes 
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10.5.2 Generic Driver Error Codes 
 

Error Code (Definition) Value Description 
CIFX_DRV_NOT_INITIALIZED  0x800B0001L Driver not initialized 
CIFX_DRV_INIT_STATE_ERROR 0x800B0002L Driver init state error 
CIFX_DRV_READ_STATE_ERROR 0x800B0003L Driver read state error 
CIFX_DRV_CMD_ACTIVE 0x800B0004L Command is active on device 
CIFX_DRV_DOWNLOAD_FAILED  0x800B0005L General error during download 
CIFX_DRV_WRONG_DRIVER_VERSION 0x800B0006L Wrong driver version 
CIFX_DRV_DRIVER_NOT_LOADED  0x800B0030L CIFx driver is not running 
CIFX_DRV_INIT_ERROR 0x800B0031L Failed to initialize the device 
CIFX_DRV_CHANNEL_NOT_INITIALIZED  0x800B0032L Channel not initialized (xOpenChannel 

not called) 
CIFX_DRV_IO_CONTROL_FAILED  0x800B0033L IOControl call failed 
CIFX_DRV_NOT_OPENED( 0x800B0034L Driver was not opened 
CIFX_DRV_DOWNLOAD_STORAGE_UNKN
OWN 

0x800B0040L Unknown download storage type 
(RAMFLASH based) found 

CIFX_DRV_DOWNLOAD_FW_WRONG_CHA
NNEL 

0x800B0041L Channel number for a firmware 
download not supported 

CIFX_DRV_DOWNLOAD_MODULE_NO_BAS
EOS  

0x800B0042L Modules are not allowed without a Base 
OS firmware 

Table 55: Generic Driver Error Codes 
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10.5.3 Generic Device Error Codes 
 

Error Code (Definition) Value Description 
CIFX_DEV_DPM_ACCESS_ERROR 0x800C0010L Dual port memory not accessable 

(board not found) 
CIFX_DEV_NOT_READY  0x800C0011L Device not ready (ready flag failed) 
CIFX_DEV_NOT_RUNNING  0x800C0012L Device not running (running flag failed) 
CIFX_DEV_WATCHDOG_FAILED  0x800C0013L Watchdog test failed 
CIFX_DEV_SYSERR 0x800C0015L Error in handshake flags 
CIFX_DEV_MAILBOX_FULL 0x800C0016L Send mailbox is full 
CIFX_DEV_PUT_TIMEOUT  0x800C0017L Send packet timeout 
CIFX_DEV_GET_TIMEOUT  0x800C0018L Receive packet timeout 
CIFX_DEV_GET_NO_PACKET  0x800C0019L No packet available 
CIFX_DEV_MAILBOX_TOO_SHORT  0x800C001AL Mailbox too short 
CIFX_DEV_RESET_TIMEOUT  0x800C0020L Reset command timeout 
CIFX_DEV_NO_COM_FLAG  0x800C0021L COM-flag not set 
CIFX_DEV_EXCHANGE_FAILED  0x800C0022L IO data exchange failed 
CIFX_DEV_EXCHANGE_TIMEOUT 0x800C0023L IO data exchange timeout 
CIFX_DEV_COM_MODE_UNKNOWN 0x800C0024L Unknown IO exchange mode 
CIFX_DEV_FUNCTION_FAILED  0x800C0025L Device function failed 
CIFX_DEV_DPMSIZE_MISMATCH 0x800C0026L DPM size differs from configuration 
CIFX_DEV_STATE_MODE_UNKNOWN 0x800C0027L Unknown state mode 
CIFX_DEV_HW_PORT_IS_USED  0x800C0028L Device is still accessed 
CIFX_DEV_CONFIG_LOCK_TIMEOUT  0x800C0029L Configuration locking timeout 
CIFX_DEV_CONFIG_UNLOCK_TIMEOUT  0x800C002AL Configuration unlocking timeout 
CIFX_DEV_HOST_STATE_SET_TIMEOUT 0x800C002BL Set HOST state timeout 
CIFX_DEV_HOST_STATE_CLEAR_TIMEOUT 0x800C002CL Clear HOST state timeout 
CIFX_DEV_INITIALIZATION_TIMEOUT 0x800C002DL Timeout during channel initialization 
CIFX_DEV_BUS_STATE_ON_TIMEOUT 0x800C002EL Set Bus ON Timeout 
CIFX_DEV_BUS_STATE_OFF_TIMEOUT  0x800C002FL Set Bus OFF Timeout 
CIFX_DEV_MODULE_ALREADY_RUNNING 0x800C0040L Module already running 
CIFX_DEV_MODULE_ALREADY_EXISTS  0x800C0041L Module already exists 

Table 56: Generic Device Error Codes 
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10.6 Error Codes netX Driver 
 

10.6.1 CIFX API Transport Error Codes 
 

Error Code (Definition) Value Description 
CIFX_TRANSPORT_SEND_TIMEOUT 0x800D0001L Time out while sending data 
CIFX_TRANSPORT_RECV_TIMEOUT 0x800D0002L Time out waiting for incoming data 
CIFX_TRANSPORT_CONNECT  0x800D0003L Unable to communicate to the deviceno 

answer 
CIFX_TRANSPORT_ABORTED  0x800D0004L Transfer has been aborted due to keep 

alive timeout or interface detachment 
CIFX_CONNECTOR_FUNCTIONS_READ_ERR
OR  

0x800D0010L Error reading the connector functions 
from the DLL 

CIFX_CONNECTOR_IDENTIFIER_TOO_LONG  0x800D0011L Connector delivers an identifier longer 
than 6 characters 

CIFX_CONNECTOR_IDENTIFIER_EMPTY 0x800D0012L Connector delivers an empty dentifier 
CIFX_CONNECTOR_DUPLICATE_IDENTIFIER  0x800D0013L Connector identifier already used 

Table 57: CIFX API Transport Error Codes 

 

 

10.6.2 CIFX API Transport Header State Error Codes 
 

Error Code (Definition) Value Description 
CIFX_TRANSPORT_ERROR_UNKNOWN  0x800E0001L Unknown error code in transport header 
CIFX_TRANSPORT_CHECKSUM_ERROR 0x800E0002L CRC16 checksum failed 
CIFX_TRANSPORT_LENGTH_INCOMPLETE  0x800E0003L Transaction with inclomplete length 

detected 
CIFX_TRANSPORT_DATA_TYPE_UNKOWN 0x800E0004L Device does not support requested data 

type 
CIFX_TRANSPORT_DEVICE_UNKNOWN 0x800E0005L Device not availableunknown 
CIFX_TRANSPORT_CHANNEL_UNKNOWN  0x800E0006L Channel not availableunknown 
CIFX_TRANSPORT_SEQUENCE 0x800E0007L Sequence error detected 
CIFX_TRANSPORT_BUFFEROVERFLOW 0x800E0008L Buffer overflow detected 
CIFX_TRANSPORT_RESOURCE 0x800E0009L Device signals out of resources 
CIFX_TRANSPORT_KEEPALIVE  0x800E000AL Device connection monitoring error 

(Keep alive) 
CIFX_TRANSPORT_DATA_TOO_SHORT( 0x800E000BL Received transaction data too short 

Table 58: CIFX API Transport Header State Error Codes 
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10.7 ODM Error Codes DBM V4 
 

 

ODM Error Codes DBM V4 
Error Code (Definition) Value Description 
CDBM_E_MD5_INVALID 0XC004C810 Checksum invalid 
CDBM_E_INTERNALERROR 0XC004C811 Internal Error 
CDBM_W_WRITEREGISTRY 0X8004C812 Error writing to the registry 
CDBM_E_UNEXPECTED_VALUE_ 
IN_OLD_HEADER_FORMAT 

0XC004C813 Error in a file containing the old DBM 
Header format. 

CDBM_E_CHECKSUM_INVALID 0XC004C814 The Checksum of the old Header is invalid 
CDBM_E_DB_ALREADY_LOADED_ FORMAT 0XC004C815 A database is already loaded 
CDBM_E_NO_VALID_TRANSACTION 0XC004C816 No valid transaction handle given 
CDBM_E_STD_STRUCT_ERROR 0XC004C817 An error occured during validation of data 
CDBM_E_UNSUPPORTED_ 
DATA_TYPE_FORMAT 

0XC004C818 Unsupported DataType 

CDBM_W_CLASS_DELETED_ FORMAT 0X8004C819 
(Warning) 

Using an Object which is marked as 
deleted 

CDBM_W_CLIENT_DISCONNECTED 0X8004C81A 
(Warning) 

A Client has already an outstanding 
connection to a Table. The connection is 
now destroyed. 

CDBM_E_STRUCTURE_DEFINITION_ INVALID 0XC004C81B A structure definition of an Element in a 
Table is invalid 

CDBM_E_NO_DATA_AVAILABLE 0XC004C81C No data available for this operation 
CDBM_E_NO_VALID_STRUCTURE 0XC004C81D No valid structure available for this 

operation 
CDBM_E_NO_TOGGLE_STRING_ FOUND 0XC004C81E No Toggle string found for this number 
CDBM_E_ELEMENT_OUT_OF_RANGE 0XC004C81F An element wasn’t found in the Record of 

a Table 
CDBM_E_ELEMENT_NOT_IN_ TABLE 0XC004C820 The element is not part of the Table 
CDBM_E_CANNOT_CONVERT_ 
INTO_CLIENT_TYPE 

0XC004C821 The data can't be converted into the Client 
type 

CDBM_E_TRANSACTION_ ALREADY_OPEN 0XC004C822 A transaction is already open. Please 
close this one first before opening a new 
one. 

CDBM_I_OLD_WITHOUT_HEADER 0X4004C823 
(Informational) 

Use of an old DBM file Format without 
Header 

CDBM_E_HR_FROM 0XC004C824 An HRESULT was received from a 
Subroutine 

CDBM_E_PARAMETER 0XC004C825 A Parameter is invalid 
CDBM_E_NOTIMPL 0XC004C826 Method is currently not implemented 
CDBM_E_OUTOFMEMORY 0XC004C827 Out of memory 
CDBM_E_NO_OPEN_TRANSACTION 0XC004C828 No transaction open 
CDBM_E_NO_CONTENTS 0XC004C829 No contents available 
CDBM_REC_NO_NOT_FOUND 0XC004C82A Record not found 
CDBM_STRUCTURE_ELEMENT_ NOT_FOUND 0XC004C82B Element of the Structure not found 
CDBM_E_NO_MORE_RECORDS_ IN_TABTYPE 0XC004C82C Table type 3 can contain only one record 
CDBM_E_WRITE 0XC004C82D The data in the VARIANT must be given in 

a SafeArray 
CDBM_E_WRITE_NO_PARRAY 0XC004C82E The VARIANT contains no valid [parray] 

element 
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ODM Error Codes DBM V4 
Error Code (Definition) Value Description 
CDBM_E_WRITE_CANT_ ACCESS_DATA 0XC004C82F Unable to access SafeArray Data in the 

VARIANT 
CDBM_E_WRITE_DATA 0XC004C830 To write the data of this Element it must be 

given as a BSTR, or as an Array of 
VT_UI1/VT_I1 

CDBM_E_WRITE_BSTR_E1 0XC004C831 The BSTR string must have an even 
length. 

CDBM_E_WRITE_BSTR_E2 0XC004C832 The BSTR string must contain only hex 
digits (0..9 and a/A..f/F). 

CDBM_E_WRITE_CANT_ INTERPRET_ARRAY 0XC004C833 Unable to interpret data in the SafeArray. 
CDBM_E_WRITE_VT_ERROR 0XC004C834 Data type in the SafeArray is not VT_UI1 

or VT_I1. 
CDBM_E_WRITE_LENGTH 0XC004C835 Data length is invalid for write operation of 

this type. 
CDBM_WRITE_ELEMENT 0XC004C836 Element not found in the Record of the 

Table 
CDBM_MIN_MAX_ERROR 0XC004C837 Can't write data because of min underflow 

or max overflow 
CDBM_TABLE_EXIST 0XC004C838 Table already exist in the database 
CDBM_MIN_MAX_INVALID 0XC004C839 The Min value is greater than the Max 

Value 
CDBM_DEF_MIN_MAX_INVALID 0XC004C83A The Default Value is not in the range 

between the Min value and the Max Value 
CDBM_CANT_CHANGE_STRUCTURE_ 
WHILE_RECORDS_EXIST 

0XC004C83B It's not allowed to change the structure 
while Records exist in the Table 

CDBM_NEW_STRUCT_NEEDS_TYPE 0XC004C83C In a newly added structure the data type 
must be set also 

CDBM_VALUE_ERROR 0XC004C83D Range error while validating a value 
CDBM_DATATYPE_ UNSUPPORTED_IN_RCS 0XC004C83E The data type is unsupported in the RCS 

file format 
CDBM_I_COUNT_OF_TABLES_ 
EXCEEDS_RCS_RANGE 

0X4004C83F 
(Informational) 

The count of Tables exceeds the RCS 
range of Tables. This can cause problems 
if the file is downloaded to RCS Systems 

CDBM_I_COUNT_OF_TABLES_ 
EXCEEDS_OLDDBM_RANGE 

0X4004C840 
(Informational) 

The count of Tables exceeds the 
DBM32.DLL range of Tables. This can 
cause problems if the file is used with older 
Tools using the DBM32.DLL 

CDBM_UNSUPPORTED_DATATYPE_ 
IN_RCS_MODE 

0XC004C841 The Data type is not compatible with the 
old database format 

CDBM_WRITE_UNSTRUCTURED_1 0XC004C842 The data of an unstructured record can 
only be written with the 'Write' Method not 
with 'WriteElement'. 

CDBM_READ_UNSTRUCTURED_1 0XC004C843 The data of an unstructured record can 
only be read with the 'Read' Method not 
with 'ReadElement' 

CDBM_WRITE_DATA_LENGTH_ INVALID 0XC004C844 The given data length doesn’t correspond 
with the expected data length. 

CDBM_UNKNOWN_VIEW_MODE 0XC004C845 The View Mode is unknown. 
CDBM_E_DIAG_TABLE 0XC004C846 It doesn’t make much sense to add or 

delete records from a diagnostic table 
because those changes are never saved. 

CDBM_E_ADR_STRING_ERROR 0XC004C847 The given Address string doesn’t fit the 
required format of this type where all 
address bytes must be in the range 
between 0 and FF 
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ODM Error Codes DBM V4 
Error Code (Definition) Value Description 
CDBM_ERROR_FROM_VAR_ CHANGE_TYPE 0XC004C848 Function VariantChangeType return an 

error when trying to convert the Parameter 
CDBM_E_MINERROR 0XC004C849 Error while comparing the Value with the 

lower range 
CDBM_E_MAXERROR 0XC004C84A Error while comparing the Value with the 

upper range 
CDBM_E_RANGE_ERROR 0XC004C84B Value out of Range 
CDBM_E_TABLE_TYPE1 0XC004C84C Table type 1 doesn’t have a unique record 

length over all records 
CDBM_E_TABLE_TYPE3_ ADDREC 0XC004C84D Table type 3 doesn’t allow to insert more 

than one Record 
CDBM_E_TABTYPE1 0XC004C84E It's not allowed to insert more Records 

than structure definitions in Table Type 1 
CDBM_E_TOGGLE_NOT_FOUND 0XC004C84F Could not find the string for this value in 

the list of valid toggle strings 
CDBM_E_TOGGLE_VALUE_IS_ EMPTY_STRING 0XC004C850 The toggle string for this value is empty. 
CDBM_VARIANT2BYTEARRAY_ ERROR 0XC004C851 Error during conversion of Variant to byte 

array 
CDBM_E_SET_ELEM_PROP_ DEPENDENCY 0XC004C852 The Toggle Type needs also the additional 

string and the additional number  entries in 
the Method 

CDBM_E_TABTYPE1_REC_ 
DOESNT_CORRESPOND_ WITH_ELEMENT 

0XC004C853 When reading the records of Table type 1 
elementwise the record number must 
correspond with the element number 

CDBM_TABTYPE1_NO_DATA_ 
FOUND_FOR_RECORD 

0XC004C854 When reading the records of Table type 1 
and structure definitions are present it's 
assumed that for each structure element a 
corresponding record must exist 

CDBM_E_TABTYPE1_WRITE_ 
ELEMENT_NE_RECORD 

0XC004C855 When writing the records of Table type 1 
elementwise and structure definitions are 
present it's only allowed to write the 
corresponding element number in each 
record 

CDBM_E_TABTYPE1_WRITE_ 
ELEMENT_NOT_FOUND 

0XC004C856 When writing the records of Table type 1 
with an array and structure definitions are 
present it's assumed that a corresponding 
element number of this record exist 

CDBM_I_TABLE_NAME_EXCEEDS_ 
RCS_RANGE 

0X4004C857 
(Informational) 

The Table name exceeds the maximum 
length of RCS compatible Table names 

CDBM_W_CUT_STRING 0X8004C858 
(Warning) 

The string exceeds the maximum length 
and will be limited to the maximum length 

CDBM_I_STRING_TOO_SHORT 0X4004C859 
(Informational) 

The string is below the minimum length. 
The minimum length will be reduced. 

CDBM_I_STRING_TOO_LONG 0X4004C85A 
(Informational) 

The string is exceeding the maximum. The 
maximum length will be extended. 

CDBM_E_STRING_TOO_SHORT 0XC004C85B 
(Error) 

The string is below the minimum length. 

CDBM_E_STRING_TOO_LONG 0XC004C85C 
(Error) 

The string is exceeding the maximum 
length 

CDBM_E_WRONG_TYPE_ FOR_WRITE 0XC004C85D Writing on the Element type with the given 
Data type is not implemented 

CDBM_E_NO_APPEND_IN_ 
STRUCTURED_RECORDS 

0XC004C85E Method IDbmRecord::AppendData is not 
allowed for structured records 
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ODM Error Codes DBM V4 
Error Code (Definition) Value Description 
CDBM_E_DATA_UNAVAILABLE 0XC004C85F No data available 
CDBM_E_CANT_CONVERT_ INTO 0XC004C860 Unable to convert the value into the 

Element type 
CDBM_E_DBM_FILE_OVERFLOW 0XC004C861 You try to write a RCS like database which 

needs too much bytes 
CDBM_E_PW_ERROR 0XC004C862 Password not correct 
CDBM_E_FILELENGTH_CORRUPT 0XC004C863 The file length doesn’t correspond to the 

length given in the Header. 
CDBM_E_STRUCT_TYPE 0XC004C864 Error in the file. 
CDBM_E_MD5SUM_INVALID 0XC004C865 MD5 sum invalid 
CDBM_E_STRUCT_LENGTH 0XC004C866 Error in the expected and given structure 

length at a specific offset in the file. 
CDBM_E_APPEND 0XC004C867 Append of data is only allowed if the 

Record contains only one data field and 
the field type will support this 

CDBM_APPEND_NOT_ SUPPORTED 0XC004C868 Append of Data not supported by this filed 
type 

CDBM_DATA_TYPE_APPEND_ ERROR 0XC004C869 Can't append Data of this type. 
CDBM_E_UNSTRUCTURED_TABLE_ 
DOESNT_SUPPORT_LENGTH 

0XC004C86A A Table without structure information 
doesn’t support a record length 

CDBM_E_DISABLED_WHILE_ 
TRANSACTION_IS_OPEN 

0XC004C86B The Method is disabled while a transaction 
is open. Please close this one first and call 
the Method again. 

CDBM_E_UNABLE_TO_CALL_ 
READ_ON_LINKED_LIST 

0XC004C86C The Method is disabled on a LinkedList 
type. Please use the IRecordCollection on 
this type. 

CDBM_E_ELEMENT_HAS_NO_ 
SUBSTRUCTURE 

0XC004C86D An Element from a Table has no 
substructure 

CDBM_STRUCT_ERROR_FROM_ 
VAR_CHANGE_TYPE 

0XC004C86E Error from calling VariantChangeType 

CDBM_E_FOREIGNKEY_DEF 0XC004C86F The definition of a FOREIGNKEY must 
contain the name of the related Table in 
the description and this Table must exist at 
this time 

CDBM_E_FOREIGNKEY_ REF_TAB 0XC004C870 The description of a FOREIGNKEY must 
refer to a Table of type 
'eDbmTableTypeLinkedList' 

CDBM_E_KEY 0XC004C871 To create a Record Collection with a KEY 
it's necessary to have the data type KEY at 
the first position in all Records of the 
searched Table 

CDBM_E_KEY_TABLE_TYPE 0XC004C872 This Method needs a Table of type 
'eDbmTableTypeLinkedList' 

CDBM_DATATYPE_NOT_ IMPLEMENTED 0XC004C873 This data type is currently not implemented 
CDBM_INSERT_POS_NOT_ FOUND 0XC004C874 The position of the Record where the new 

one should be inserted wasn’t found 
CDBM_E_INSERT_REC_QI 0XC004C875 Error during insertion of a Record 
CDBM_E_TAB_PROP 0XC004C876 Invalid Property in Table 
CDBM_E_KEY_NOT_FOUND 0XC004C877 The KEY wasn’t found in the Table 
CDBM_E_KEY_INVALID 0XC004C878 The KEY is invalid for this operation 

Table 59: ODM Error Codes DBM V4 
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11 Appendix 
11.1 COB-ID (Predefined Connection Set) 

COB ID stands for communication object identifier. This is the 11 bit 
covering telegram identifier of a CAN telegram. Thereby the upper 4 bits 
(bit 11 to 8) are the function identifier and the lower 7 bits (bit 7 to bits 0) 
the bus address of the node. 

Broadcast Objects: 
 

Object Functio
n Code 

COB ID  
hex 

COB ID  
dec 

Index in the Object 
Dictionary 

NMT 0000 00H 0 - 
SYNC 0001 80H 128 1005H, 1006H, 1007H 
TIME STAMP 0010 100H 256 1012H, 1013H 

Table 60:  COB ID - Broadcast Objects 

 

Peer-to-Peer Objects: 
 

Objects Functio
n Code 

COB ID  
hex 

COB ID  
dec 

Index in the Object 
Dictionary 

Emergency 0001 81H-FFH 129-255 1014H, 1015H 
PDO 1 (tx) 0011 181H-1FFH 385-511 1800H (1A00H) 
PDO 1 (rx) 0100 201H-27FH 513-639 1400H (1600H) 
PDO 2 (tx) 0101 281H-2FFH 641-767 1801H (1A01H) 
PDO 2 (rx) 0110 301H-37FH 769-895 1401H (1601H) 
PDO 3 (tx) 0111 381H-3FFH 897-1023 1802H (1A02H) 
PDO 3 (rx) 1000 401H-47FH 1025-1151 1402H (1602H) 
PDO 4 (tx) 1001 481H-4FFH 1153-1279 1803H (1A03H) 
PDO 4 (rx) 1010 501H-57FH 1281-1407 1403H (1603H) 
SDO (tx) 1011 581H-5FFH 1409-1535 1200H 
SDO (rx) 1100 601H-67FH 1537-1663 1200H 
NMT Error 
Control 

1110 701H-77FH 1793-1919 1016H, 1017H 

Table 61:  COB ID - Peer-to-Peer Objects 
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11.2 User Rights 
User-rights are set within the FDT-container. Depending on the level the 
configuration is accessible by the user or read-only. 

To access the Settings, Configuration, Device Description and 
Diagnosis panes of the CANopen Slave DTM you do not need special user 
rights. Also all users can select the decimal or hexadecimal Display mode 
or sort table entries. 
 

 
Note: To edit, set or configure the parameters of the Settings and 
Configuration panes, you need user rights for Maintenance, for Planning 
Engineer or for Administrator. 

 

The Device Description panes do not contain any editable elements. The 
indicated values in are only for information purposes. 

The following tables give an overview of the user right groups and which 
user rights you need to configure the single parameters. 
 

11.2.1 Settings 
 Observer Operator Maintenanc

e 
Planning 
Engineer 

Adminis-
trator 

Driver D D X X X 
 Selecting the Driver  - - X X X 
 Configuring the Driver - - X X X 
Device Assignment D D X X X 
 Scanning for Devices - - X X X 
Selecting the Device (with or 
without firmware) 

- - X X X 

Selecting the Device once more 
(with Firmware) 

- - X X X 

Firmware Download D D X X X 

Table 62: Settings ( D = Displaying, X = Editing, Configuring) 

 

11.2.2 Configuration 
 Observer Operator Maintenanc

e 
Planning 
Engineer 

Administra
tor 

     Overview Configuration D D X X X 
     General Settings  D D X X X 
     Special Function Objects D (X) D (X) X X X 
     Object Dictionary D (X) D (X) X X X 
     Process Data Objects D (X) D (X) X X X 
        PDO Properties D (X) D (X) X X X 
        PDO Mapping D D X X X 
     Address Table D D X X X 

Table 63: Configuration (D = Displaying, X = Editing, Configuring) 
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11.3 References 
[1] Device Type Manager (DTM) Style Guide, Version 1.0 ; FDT-JIG - Order No. 

<0001-0008-000> 
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13 Glossary 
COB-ID 

Communication Object Identifier. Identifier of the CAN telegram. 

DTM 

Device Type Manager 

The Device Type Manager (DTM) is a software module with graphical user 
interface for the configuration and/or for diagnosis of devices. 

EDS 

An Electronic Data Sheet (EDS) provides information necessary to access 
and alter the configurable parameters of a device. An Electronic Data Sheet 
(EDS) is an external file that contains information about configurable 
attributes for the device, including object addresses of each parameter. The 
application objects in a device represent the destination addresses for 
configuration data. These addresses are encoded in the EDS. 

FDT 

Field Device Tool 

FDT specifies an interface, in order to be able to use DTM (Device Type 
Manager) in different applications of different manufacturers.  

Master 

Master devices initiate the data exchange at the bus. 

Node ID 

The Node ID is the network address of the device. The network address 
serves to distinguish itself from other devices on the network. Therefore an 
unique address must be assigned to each device.  

Slave 

Slave devices are configured by the Master and perform then the 
communication. 
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